MultiWorks for DOS
�



1
0 integrated applications, with 
a common user interface
 
   
(see the next few pages for a complete list of features)



4 years on the market as a commercial product
 (approx 40,000 copies sold)



bug free



complete, unlimited
, unrestricted 
version


a host of features designed to save time and effort



complete manual in both MS Word and text formats


mouse driven with 
e
asy to use drop down menus and popups.


dBase & Lotus compatible



minimum installation requires only 360K of disk
 
space









Registration fee ... $2.00








A
re you paying enough ?





	
Good question! 
 
Try a
sk
ing
 yourself this
; 
“Am 
I
 paying 
t
oo much
 for other Shareware products
?
”  In most cases the answer is yes.  If a given software product were to be published and sold on retail stores shelves for $50.00, the author of th
e product would receive about $3
.00
 to $4
.00 per copy.  Why?  After packaging, advertising, marketing, etc. etc. etc., there really is very little left over for the author.
 (that
’s why selling a million copies of a product is so appealing)
  On the other hand, if this same author were to re
lease the product as shareware and charge $30.00 for it he would pocket the whole 



amount.
 
 
One of the major concepts of Shareware was the elimi
n
ation of the middlemen.  If the 
middleman is gone, why 
are you s
t
ill paying 
for 
him?





	Two dollars
 is about what 
I
 would receive for each copy of MultiWorks sold if it were 
still a commercial product.  Since the middleman is gone, so is his fee.





	
So come on, grab a $2.00 bill and stuff it in an en
velope
 and mail it off.  You
’ll get t
o use a great piece of software
, and you
’ll have the satisfaction of knowing that you
’ve paid exactly the right price for it.








d
eskSoft Computer Services Inc.


217 East 23rd Street

Hamilton, Ontario
, Canada


L8V 2X2








... 
Coming
 soon MultiWorks for Windows ... all of the same features and more! 



(send $1.00 plus a self addressed, stamped diskette mailer (
include 
3ea 
HD 3.5
” 
diskettes) for an advance copy)










SHAREWARE NOTICE





MultiW
orks is supplied free of charge.  You are encouraged to copy and distribute 
it to as many people as possible under the following conditions :



1)	MultiWorks must
 be distributed in its original,
 unchanged or unmodified format.



2)	No fee may be charged for distribution of the produc
t, except a nominal fee for the price of copying and a 
   


	
diskette.
	






3) 	In order to be granted a licence to use the product legally, you must register by sending $2.00 (US funds) to the 


	
above address.
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18 Applications in One Package



Applications:



Word Processor - Edit files up to 20mb in size, Word wrap, Headers/footers, Block Cut, Copy & Paste, Search & replace, Edit Tabs, Font & Typeface control, Smart page breaks, Optional automatic save and backup.



Spreadsheet - Maximum 702 Columns by 10,000 rows, 18 built in formulas, Graphing, Copy, move & delete ranges, Font & typeface control, Format control, Read and write Lotus(tm) .WK1 Files, Import from other spreadsheets, Last sheet autoload



Database - dBase III file compatible, Browse & Edit modes, Memo editor, Logical replace, delete, count, recall functions, Set logical, field or range filters, Append from / write to text files, Last file autoload



Address Book - Unlimited expandability, Room for 3 lines of address information, two phone numbers, fax number, extension, & contact name, User definable groups, Memo pad for each entry, Built in searches, Print 'Black Book' of names & numbers, Dial telephone



Alarms - Set up to 15 different alarms per day, Each alarms has a separate message line, Set alarms any number of days in advance, Alarms will ring anywhere within MultiWorks and display time and message line



Calendar Maker - Create one or twelve month calendars, Miniature year across top, followed by full page for each month



Calculator - Pops up from any MultiWorks application, standard handheld calculator features, such as memory add and subtract, and all normal math functions such as add, subtract, multiply & divide



Communications - 110 to 9600 baud operation, XMODEM & YMODEM upload and download, ASCII file capture and send, Editable dial directory,  Fully customizable, Host mode for remote access.



Data Encryption -Protect important files from unauthorized access, 1 to 20 character user definable password, fast, secure encryption



DOS Shell - DOS functions such as copy delete rename & move, run other DOS programs from menu, locate files, list files, global delete, system information, format menu, print files



Information Manager - Quickly file miscellaneous notes such as recipies, shopping lists, inventory lists, or other unrelated information



Mail Merge - Use the infrmation in the address database to design and layout form letters with almost any style and format



Mailing Labels - Print address information on any size of labels or envelopes, Print one, Several, or All at a time, Print with font & typeface control



Report Creator - Generate fixed or free format reports from Database files, Add comments, and or header information, Fixed format can produce totals, and evaluate formulas, Print with font & typeface control



Spell Checker - 56,000 and 8,000 word Dictionaries, Alternate user dictionary,  Unlimited expandability, Unlimited input file size.



System Information - Display information about the type of computer system, Memory, Input/output ports, DOS version, and Relative speed index



Time Manager - Scrolling calendar, Memo pad for each day with optional time of day marks, Annual dates, Goto date function (directly, or +/- number of days), Calendar indicates which dates have appointments, Print memos by common content or by range of dates



To-Do List - Time and date stamp start & completion of each item, Display pending  or complete lists or both, Print pending, completed or both,  Accessible from anywhere in the program.



General Features - Online Help, Import from / Export to common clipboard, Standard Interface, Pull Down Menus, Pop up Dialog Boxes, Full Mouse or Keyboard Operation, Print to Printer, Disk or Screen, Use resident printer fonts, access to internation character set



Requirements - IBM PC or 100% Compatible computer, 640K memory, Hard Disk Recommended, DOS 3.1 or higher, Monochrome or Colour Monitor



Optional Equipment - Microsoft(tm) Mouse, Hewlett Packard(tm) LaserJet, IBM(tm) Proprinter, Epson(tm) 9 or 24 pin or compatible printers, Hayes(tm) Compatible modem

�Installation 
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System Configuration



	In order for MultiWorks, or the Install program to perform correctly on your system, you must be sure that the CONFIG.SYS file on your boot disk or diskette contains the statement 'FILES=xx' and that xx is greater than or equal to 20.  This setting is important both before and after the installation is performed.  If you do not have it set properly, neither the Install program nor the MultiWorks program will execute. 





Installation Notes



	Keyword surrounded by <> signs refer to actual keys on the keyboard.  Commands to be entered into the computer will be surrounded by single quotation marks ' Do not type these marks! 



	You must have a file called "CONFIG.SYS" on your boot drive or diskette.  This file must contain the line "FILES=20" (or a number greater than 20)  If you do not have this file, or the number of files is too low, you will not be able to install MultiWorks.  Before installation can be completed, you must increase the number, or add the "FILES=20" line to the "CONFIG.SYS" file and then reboot your computer.  If a setting of 20 does not work, try increasing the number.  Some systems or configurations require up to 40 files to be specified.  Installation problems are almost always the result of this feature having been improperly set.  Please refer to your DOS manual for more information on the FILES statement. 



	The single floppy install procedure requires a blank formatted diskette and the  program called DISKCOPY.COM found on the standard DOS diskettes.  If you cannot locate the DISKCOPY.COM program, please refer to your DOS manual. 





How to Format a Diskette



	Formatting is the process by where a diskette is prepared for its initial use.  Usually a diskette needs to formatted only once, after which it can be reused again and again.  To format a diskette you will need access to the FORMAT.COM program that comes with all versions of DOS.  Insert the diskette that contains the FORMAT.COM program and type FORMAT A: <ENTER>.  After a few seconds you will be prompted to insert the target diskette.  Remove the diskette containing the FORMAT.COM program and insert the blank (or target) diskette.  Press <ENTER> to start the format process.  Depending upon your version of DOS, the format program will display a running status of the formatting process.  When complete, answer <N>o when asked if you want to format another diskette.  Remove the newly formatted diskette from the drive and store in a safe place. 





�How to Create a CONFIG.SYS File



	Insert your DOS diskette into the disk drive and turn your computer on.  When the Boot process is complete (you should see the 'A:\' prompt), type the following:  



TYPE CONFIG.SYS <ENTER>. 



If the computer responds 'File Not Found', type the following exactly as shown: 



COPY CON CONFIG.SYS <ENTER>

FILES=20

<F6><ENTER>



	Or, if the computer displays the contents of an existing CONFIG.SYS file, examine it for the 'FILES=' line and if necessary, modify it (using EDLIN or an editor of your choice) to equal 20 or more. 





Installation for Hard Drive, and Dual Floppy Users



1) Boot your system as you normally do. (See installation notes above.)



2) When the DOS prompt appears "C:>" .or. "A:>" insert the MultiWorks Install/Dictionary diskette (for 5.25" users) or the Program diskette (for 3.5" users)  into either diskette drive A: or B:.  (For Dual Floppy users, make sure it is the NON Booting Drive) 



3) Change to the drive that contains that diskette by typing that drive letter and a colon (eg. "A:") and then pressing the ENTER key. 



4) Run the MultiWorks Install program by typing 'INSTALL <ENTER>'. 



	Once the Install program has been loaded, 5.25" diskette users will be prompted to insert the Program/Data diskette and press <ENTER>.  You must now supply the following information.  If you make a typing error, use the backspace key to erase, and then retype your information.  At almost any time you can move between the various information fields by pressing the Up or Down arrow keys.  Some fields are attached to lists of options (ie Printer type, DOS version, Dictionary), press ENTER in that field to select from the attached list. 

Please fill in all information properly. 



-	Enter the Source Drive information (should already be correct), the source drive is the one with the MultiWorks original diskette in it. 



-	Enter the Destination Drive information (the drive and directory that you wish MultiWorks to be installed upon)  This option defaults to "C:\MWORKS".  Change it if you wish MultiWorks to be installed elsewhere on your system. 



-	Enter "C" if you have a colour monitor, or "M" for a monochrome, or black and white monitor. 



-	Select the type of printer that you use.  Although not all printer's names are 	listed, the printer drivers included can handle almost any printer.  If you are not 	sure, select the GENERIC model. 



-	Select the version of DOS that you are now using.  This is very important for DOS 4 and DOS 5 users.  (select DOS 4.01 if not sure) 



- 	Enter your company name.  If this copy of MultiWorks is not being used by a company, please leave this section blank.  



-	Enter your own name. (First and Last) 



-	Select which dictionary (or none at all) to install. 



-	Select "Y" or "N" to install the help files.



-	Enter "Y" to initiate the installation process, or "N" to cancel. 



-	Wait while files are copied, and insert diskettes as requested (5.25" users)



-	If you have a hard disk drive, you will be prompted to allow the Installation 	program to modify your AUTOEXEC.BAT file.  If you answer 'YES', the path statement will be modified to include the sub-directory that you have MultiWorks in.  This is necessary in order to run the Utilities from any other drive or directory.



7) MultiWorks is now installed.  Run the program by typing 'MW <ENTER>'. 



Installation for Single Floppy Drive Users 

(1.2mb 5.25" or 720K/1.44mb 3.5") 



In order to install MultiWorks correctly, you will need the following items: 



-	A bootable (DOS) diskette that conforms to the instructions in the Installation 	Notes written above

-	One blank, formatted diskette (see previous instructions)

-	Materials suitable for labeling one diskette

-	A diskette that contains the XCOPY.COM program 



1) Boot from the DOS diskette.



2) Label the blank diskette as "Working Copy"



3) When the A:> prompt appears, insert the diskette containing the XCOPY.COM program. 



4) Type the following 'XCOPY A: B: <ENTER>'.  When prompted to, remove the DOS diskette, insert the "MultiWorks Program/Data" (5.25") or Program/Install (3.5") diskette (known as SOURCE) and press '<ENTER>'.  After approximately 30 seconds or so, you will be prompted to insert the 'Target' diskette.  At this point, remove the "MultiWorks Program/Data" diskette and insert the blank diskette labeled "Working Copy" and press '<ENTER>'.  (this process creates a Backup copy of the Program/Data diskette) 



5) Type 'A:' and press <ENTER>



6) When the XCOPY process is complete, answer 'No' to the prompt, and then insert the "MultiWorks Install/Dictionary" diskette into the drive.  Place the "MultiWorks Program/Data" diskette in a safe place.  Run the Install program by typing 'INSTALL' and pressing the '<ENTER>' key.  After a few seconds, the Install program will prompt you to insert the Program/Data ("Working Copy") diskette.  Insert it, and then press <ENTER>. 



		Once the Install program has been loaded, 5.25" diskette users will be prompted to insert the Program/Data diskette.  If necessary, do so, and then press <ENTER>.  You must now supply the information asked for below.  If you make a typing error, use the backspace key to erase, and then retype your information.  At almost any time you can move between the various information fields by pressing the Up or Down arrow keys.  Some fields are attached to lists of options (ie Printer type, DOS version, Dictionary), press ENTER in that field to select from the attached list. 





Please fill in all information properly. 



-	Enter the Source Drive information (should be "A:\"), the source drive is the one with the MultiWorks Program diskette in it. 



-	Enter the Destination Drive information (again this should be "A:\".  If it is not, change it.) 



 -	Enter 'C' if you have a colour monitor, or 'M' for a monochrome, or black and 	white monitor. 



-	Select the type of printer that you use.  Although not all printer's names are listed, the printer drivers included can handle most any printer.  If you are not sure, select the GENERIC model. 



-	Select the version of DOS that you are now using.  This is very important for 	DOS 4 and DOS 5 users.  (select DOS 4.01 if not sure) 



-	Enter your company name.  If this copy of MultiWorks is not being used by a 	company, please leave blank.  



 -	Enter your own name. (First and Last) 



-	Select which dictionary to install.  If you are using a 3.5" or High Density 5.25" diskette, you can select the 8,000 word dictionary.  Due to disk space limitations, users of 360K 5.25" diskettes will have to select "No Dictionary". 



-	Select "Y" or "N" to install the help files.  For systems with low disk space, skipping the Help files will save over 35K of disk space.



-	Enter 'Y' to initiate the installation process, or 'N' to cancel. 



-	Wait while the Installation process is completed. 



7) MultiWorks is now installed.  Run the program by typing 'MW <ENTER>'. 





Installing the Dictionary Manually



		There are two versions of the MultiWorks dictionary, the first is a 56,000 word version that contains both common, and less-common words.  The second version is a smaller (8,000 words), common use dictionary that contains most of the words used in everyday writing.  The 56,000 word dictionary requires almost 2 megabytes of disk space, making it usable only for people with hard drives.  The smaller, common use dictionary consumes only about 400 K of disk space, and can be used by a 3.5", or a high capacity 5.25" diskette user. 



		To install the 56,000 word dictionary after installing the rest of the MultiWorks program, copy the file DICT_56K.EXE from the dictionary diskette to your MultiWorks sub directory, then execute it (by typing 'DICT_56K' <ENTER>).  DICT_56K.EXE is a self uncompacting file.  When the decompaction process has been completed, you may delete the file DICT_56K.EXE.  Now execute MultiWorks 15 and select Reindex Files (F3 from the Maintenance Screen screen). 



		To install the common use dictionary after installing the rest of the MultiWorks program, copy the file DICT_8K.EXE from the dictionary diskette to your MultiWorks sub directory, then execute it (by typing 'DICT_8K' <ENTER>).  DICT_8K.EXE is a self uncompacting file.  When the decompaction process has been completed, you may delete the file DICT_8K.EXE.  Now execute MultiWorks 15 and select Reindex Files (F3 from the Maintenance Screen).  



�Copyright Notice



Copyright (c) 1989-1992 deskSoft Computer Services.

Copyright (c) 1991-1992 Wizardworks Group Inc.

All rights reserved.



	This version of MultiWorks is NOT public domain, free software, or Shareware.  It is a copyrighted commercial product, and neither it, nor the accompanying documentation may be copied! 





License 



	Registered users of this software are granted a limited license to use this software on one PC or workstation at a time.  Unauthorized copying, duplication, or transmission of the program or the accompanying documentation is a direct violation of this license. 





Disclaimer 



	Use of this program acknowledges this disclaimer of warranty: "This program is supplied as is.  deskSoft Computer Services and Wizardworks disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness of this program for any purpose.  deskSoft Computer Services and Wizardworks assume no liability whatsoever for any damages direct or consequential, which may result from the use or misuse of this program." 





Trademarks



dBase, dBase III are registered trademarks of Borland International.

Lotus, and Lotus 123 are registered trademarks of Lotus Corp.

IBM, IBM PC, XT, AT, and PS/2 are registered trademarks of International Business Machines Inc. 

Hayes is a registered trademark of Hayes Electronics Inc.

CompuServe is a registered trademark of CompuServe Information Systems Inc.

Microsoft is a registered trademark of Microsoft Inc.



All other trademarks are the property of their respective owners.  





Requirements



	MultiWorks requires an IBM PC or an 100% IBM compatible with at least *640K and one floppy disk drive to operate.  This is the minimum configuration.  In order to use the 56,000 word spell checker, you will need 2 megabytes of disk space, (ie a hard drive).  MultiWorks works on either monochrome or colour monitors.  Most common printers are supported.  A Microsoft or compatible mouse is also supported. 



* (Tests have shown that MultiWorks will run with only 500K of free memory, but for best results, 550K or greater free memory is recommended.) 

�The Anatomy of MultiWorks 



The Applications



	The Applications part consists of 10 programs, and a Maintenance Screen, tied together by the Main Menu.  Within these 10 programs you can perform the more than 18 different applications.  The Main Menu is the screen that first appears when you run MultiWorks.  This screen allows access to any of the ten applications, as well as displaying copyright and registration notices. 



	Throughout the manual, these 10 programs will be called the 'MultiWorks Applications', 'Programs', or will simply be referred to by name.  They are: The Spreadsheet, The Word Processor, The Spell Checker, The Database, The Communications Package, The Address Book, The Time Manager, The DOS Shell, The File Encryptor and the Info Manager. 





Loading MultiWorks 



	There are two ways to load MultiWorks.  The first way to type MW at the DOS prompt and press ENTER.  This will load MultiWorks and bring you to the main menu.  The second method allows you to access any of the programs directly.  To do this, type MW at the DOS prompt, followed by a space and the single letter code that represents the application you want to run directly. 



Spreadsheet 		MW  S

Word Processor		MW  W

Spell Checker		MW  P

Database		MW  D

Address Book		MW  A

Time Manager 		MW  T

DOS Shell		MW  Q

Communications 		MW  C

Info Manage		MW  I

File Encryption		MW  F

Maintenance		MW  M 



(These codes are the same as the first letter of each application name in the main menu.)





Using a Mouse with MultiWorks



	MultiWorks supports the Microsoft or any Microsoft Compatible mouse.  The mouse offers you an alternative method of selecting and executing commands and options.   In order to use the mouse properly, the appropriate mouse driver must be loaded prior to executing MultiWorks.



Several specialized terms are often associated with mice, they are as follows; 



Click - to press and release the mouse button (usually the left hand one)



Pointer - the small rectangle on screen that moves when the mouse is moved. (Much like a cursor.) 



Point - to move the mouse pointer until it rests on top of a desired area on the screen. 



	You may use the mouse to select any command listed in the menu bar (at the top of the screen), by pointing at it and then clicking.  If that command brings up an menu, you can select the menu item of your choice by moving the mouse pointer on top of it, and clicking again (with the left button).  Some windows, like the File Selector and the Help Screen, have special control areas on the left hand side for the mouse only.  Clicking on the up or down arrows moves the display up or down one line.  Clicking on the other areas (shaped like three horizontal lines and called page up/down symbols) causes the display to move up or down one page at a time.  Click outside of these windows to cancel the operation.  In any memo pad, note pad, or word processing area, you may position the text cursor by pointing at the desired point and clicking. 





Command Selection 

  

	There are three ways to select options and commands within MultiWorks. They are as follows : 





Full Screen Menus
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	Only the Main Menu uses this type of command selection.  With this menu you can use the up and down keys to move the cursor up and down the list.  To select a command, highlight it and press ENTER, or press the first letter of the command you wish to invoke. Cursoring beyond the end of the list will cause the cursor to return to the top, and moving beyond the top will cause the cursor to appear at the bottom. 



MOUSE - Point at any of the menu selections and click the left mouse button to select that MultiWorks application. 





Pull Down Menus
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	These are small menus that appear after certain function keys are pressed, (in the Word Processor, the Spreadsheet, the Database, the Address Book, the Time Manager, the Info Manager, the Communications Program, and the DOS Shell).  Each will display one or more options.  To select an option, use the up and down cursor keys to highlight the one desired, and then press ENTER to select it.  You may also press the first letter of the desired option to move the cursor directly.  Unlike the Main Menu, you must then press ENTER to activate it. 



MOUSE - Select the pull down menu by clicking on the menu name with the left mouse button.  Then point to the desired menu item, and click again with the left mouse button. 





Keyboard



	All other commands are accomplished by pressing function keys, or a variety of ALT and CTRL key combinations.  Function keys are F1 - F10, as well as keys like HOME and INSert.  The commands that each key will activate are listed at the top of the screen.  ALT and CTRL key combinations are accomplished by holding down either the ALT or the CTRL key and then pressing another key on the keyboard.  The ALT and CTRL key combinations most often overlap those of the Pull Down Menus.  In such a case the keystrokes are listed to the right of the command in the pull down menu. 



MOUSE - Pointing at any command or menu name in the menu bar and clicking with the left button will cause that command to be executed, or menu activated. 



Pop-Up Boxes
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	Pop-up boxes, sometimes referred to as Dialogue Boxes are one line messages that appear (usually) in the middle of the screen.  They inform you of events happening within the program and often ask you to select options.  There are three main types of Pop-up boxes;



	The first simply displays the message line on the screen and waits for any keypress or mouse click.  



	The second, displays its message and then allows you to select one of three options.  To select one of these options, you may:  type the first letter of the option name, tab or cursor left or right until the desired option is selected and press ENTER, or point at the desired option with the mouse and click.  



	The final type of Pop-up box contains a message line and blank area that you must fill in.  In most cases, this blank area will already contain a default setting. 





Exiting a MultiWorks application 



	To exit from any application and return to MultiWorks menu, press the ESC key, or, if available, select Exit from the File pull down menu.  To exit from the Main Menu back to DOS, press ESC, or with the mouse, click on the very top or bottom of the screen. 





Printing 



	When printing from any MultiWorks application, you have several output options. 



	The first; "Printer", sends the output to the printer currently connected to the selected printer port. (See the Maintenance Screen to modify this)  The third option "Screen", displays the information on the screen as it would be printed.  The second option "Disk", gives you two choices.  The first, "File" causes the data to be printed a disk file with the specified filename.  This file can then be copied onto a diskette and transported to another PC for printing.  "Clipbrd" allows you to print the data to the Clipboard, in order to make it accessible to other MultiWorks applications.      





Printing to a Shared or LAN Printer



	Users connected to a LAN or Local Area Network printer have another option when printing.  Normally, most LAN's wait until the entire print job has been sent out from the computer before starting to print it.  This results in some rather unnecessary delays.  To overcome this problem, you must indicate to MultiWorks that you are using a LAN printer.  Do so by entering the word 'LAN' (without the quotation marks) in the Print Device field in the maintenance menu.  It may go in front of, or behind the actual print device (LPT1, PRN, LPT2, etc). 





Printer Drivers



	A variety of printer drivers come with the MultiWorks package, the list, although small should allow almost all printers to be used.  If you need to add a new printer driver, or modify an existing one to suit your needs, please read the Printer Driver paragraph in the Maintenance Screen chapter. 





�Printing with Different Fonts



	Many printers are now being shipped with a variety of internal fonts, some of which you may wish to use.  To access them, you may be required to add or modify the font code sequence in your printer driver.  See the Maintenance Menu and the Word Processor chapters for more information. 



	Whenever the New Font option is specified, the font number desired must be placed directly after the font character! 





Using the File Selector 
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	The Spreadsheet, the Word Processor, the Spelling Checker, the Database, the DOS Shell, and the File Encryptor/Decryptor all use the same means to locate and select a file or files. 



	This File Selector allows you to pick files, change directories and drives, enter a display specification to list only certain filenames, print the current directory and even list the file currently highlighted. 



	To select a file, first move the light bar until it is highlighting the desired filename, and then press the ENTER key.  To move the light bar, use the cursor keys, or press the first letter of the file to be found.  



	An alternate way of selecting files, is to type the filename (if you know it) one character at a time.  As you enter each character, the letters you have typed will appear above the list, and the cursor will move to the first file name that starts with those letters.  Moving the cursor manually, pressing the space bar, or pageup/pagedown keys will cause the search to be reset. 



MOUSE - Point at the desired filename or directory name and click with the left button to select it.  



Click on the up/down arrow and page symbols to move quickly through the list.  Click outside of the File Selector window to cancel the operation.  (Some of the functions in the DOS Shell allow you to select multiple files.  To do this, press the TAB key or CONTROL-ENTER on the highlighted entry.  ENTER or ESC alone terminates this selection process.) 



MOUSE - Point at the desired filename click with the right button to tag it as selected. 



	Placing the cursor over a subdirectory name, and pressing ENTER causes that subdirectory to become current (ie DOS's CD command).  Highlighting the item called '..   Root' causes the root directory to become current (ie CD\).  Highlighting the item called '.. Previous' causes the subdirectory immediately above the present one to become current (ie CD..).  

�	Press F1 for help at any time.  Press F2 to enter a filename manually. If this file does not exist in the current drive and directory, you must supply the full drive and pathname.  Press F3 and select a drive letter from the displayed list to change the active drive.  ESC exits the File Selector and causes the file operation to be cancelled (unless you were selecting multiple files)  Pressing F4 allows you to enter a new file specification (extenders only).  This allows you to 'screen' out unwanted filenames from the displayed list.  The F5 key prints the current directory to screen, printer or disk.  The F6 key allows you to view the file currently being highlighted.  When viewing large text and non-database/spreadsheet files, you will only be able to see the first 10K or so (depending upon the segment size).  If the file is a spreadsheet or database file it will be viewed in its native format. 



	When in the DOS Shell, the following keystrokes are also active; 



ALT S - Select all files

ALT U - Unselect all files

ALT R - Reverse selection status of all files





Help 



	The F1 key will give application specific help from almost anywhere.  Use the up and down cursor keys to view the help, and press ESC to exit.  



MOUSE - Click on the up/down arrow and page symbols to move through the help information.  Click outside of the Help window to cancel Help.  



Case Indication 



	When using the Word Processor, the Address Book Memo Pad, the Database Report Generator, or the Time Manager Note Pad, the cursor will be green when you are typing in lower case, and red when you use upper case. 





Main Menu Application Replacement 



	Another feature of MultiWorks is it's adaptability when it comes to running other DOS applications.  It's reasonable to assume that one day you will outgrow one or more of the built-in MultiWorks applications.  You may need to use another word processor, or need access to more spreadsheet functions.  You will also want to keep the other MultiWorks Applications close at hand, and easily accessible. 



	The most obvious way of getting around this problem is to add the new applications to the 'Run Applications' menu in the DOS Shell.  This of course will allow you to run them without any problems, but makes the execution of commonly used applications more cumbersome than necessary.  To avoid this kind of headache, the nine application items in the Main Menu have been made to be replaceable.  This means, that if you find that the MultiWorks Spreadsheet no longer fulfils all your needs, you can program the 'Spreadsheet' option of the Main Menu to load your copy of "Lotus 123". 



	To replace a main menu item with another application is a two step process.  First add the desired application into the 'Run Applications' menu in the DOS Shell.  (See the instructions in the DOS Shell chapter for more information) Once the desired application appears in this menu, return to the Main Menu and position the cursor over the menu item that you want to replace. 



	Pressing CONTROL-ENTER will cause a menu of applications (the same as in the DOS Shell) to appear.  Select the external application to take the place of the MultiWorks application and press ENTER.  From now on, every time you select that menu item, the selected external application will be executed instead. 



	If you want to use the original MultiWorks application again, you must first turn off any replaced menu item by highlighting it, and pressing the DELete key. 



Please Note: 	This process will not affect the operation of the chosen application in the DOS shell, nor will it affect the ability to add a 'Live' parameter when executing. 





�The Clipboard 



	The Clipboard is simply a temporary storage area for data.  The Clipboard functions as a medium of exchange that allows different applications to transfer data back and forth.  Placing information or data into the Clipboard is called Importing, and retrieving that information back from it is known as Exporting. 
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	All applications that can print data, can also Export it by selecting Print to Disk, and then Send to Clipboard.  The Word Processor, the Spreadsheet, the Database, the Address Book and the Info Manager can all Import and Export directly from either the File Menu or another command key.  The Time Manager however, can export only from the print command, and cannot Import any data at all. 



	For all applications, there are minor differences when Importing and Exporting data. 





Word Processor



Import - Selecting Import from the File menu causes the current document to be replaced by the imported data.  You have the choice of changing the Tab setting to match the format of the Imported data.   If you select Import Block (Clipboard) from the Block menu, you can insert small (smaller than segment size) amounts of data, without altering the current document. 



Export - Export from the File menu exports the entire document.  Exporting from the Block Menu (Export Block (Clipboard)) only exports the currently defined block of text. 





Spreadsheet



Import - The Imported data can be appended to the bottom of the spreadsheet, or used to replace the entire sheet.  The width of each column can be optionally altered to match the format of the imported data.  The Import/Export to Clipboard functions are not to be confused with the import range function found under the Copy menu. 



Export - The number of columns to be export must be defined, but the entire range of rows is exported automatically. 





Database



Import - A new database is created to match the format of the imported data, fields are named 'FIELD_1, FIELD_2,' etc.  The Import/Export to Clipboard functions are not to be confused with the file append/write functions found under the file menu. 



Export - The entire database is exported. 





Address Book



Import - The data to be Imported must be formatted correctly.  The proper format has one field per line (ie name, Postal/Zip code, and fax are all fields).  Try exporting an entry to examine the format structure. 



Export - Only one entry at a time is exported.  To export more than one at a time, use the "Clipbrd" option from within the print command. 





Info Manager



Import - Imported data must not exceed the current segment size. 



Export - Exported data is formatted to 50 columns 



Global Functions



	The following functions can be accessed from anywhere within MultiWorks with a single keystroke.





The Pop-Up Calculator
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	For your convenience, a simple pop-up calculator has been added to the MultiWorks suite of applications.  This calculator replaces the older standalone version, and has several differences. 





Activating the Calculator



	The pop-up calculator can be "popped-up" anywhere in the program (except the Title page) by simply pressing ALT 3. 





Using the Calculator



	Once active, you can use the calculator by pressing any of the numeric keys on either the keyboard or the keypad.  Mathematical operations are performed by pressing the appropriate operation key.  The following is a list of these keys along with their mouse equivalents. 





Keyboard   Mouse      Description



.	.	Insert a decimal place

+	+	Add to the current total

-	-	Subtract from the current total

* 	*	Multiply the current total

/	÷	Divide the current total

^	^ 	Square the current total

\	_ 	Calculate the square root of the current total 

=	=	Calculate the total

C	C	Once clears the value, Twice clears the total

N	±	Toggle the negative status of the current value

H		Help

M	MC	Clear Memory

R	MR	Recall Memory

A	M+	Add to the current memory value

S 	M-	Subtract from the current memory value

INS		Causes the current total to be inserted at the 	present  cursor location



	The pop-up calculator will work almost exactly the same as an ordinary pocket calculator. 

     



�Moving the Calculator



	Although small, the pop-up calculator can sometimes obscure important information on the screen.  To move the calculator around the screen, simply press any of the four cursor directional keys (left, right, up, down) and the calculator will follow. 



MOUSE : Click anywhere on the screen, and the calculator will move to that location. 





Exiting the Calculator

	

	To remove the calculator from the screen and return to the work you were doing previously, press the ESC key. 



Accessing International Characters
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	To use characters that are not available directly from your keyboard, press ALT 4.  A menu will appear at the right hand side of the screen containing a list of these special characters.  Simply position the cursor over each desired character and press ENTER to select it.  When you have selected the character(s) you want, press ESC and they will be inserted at the present cursor location.



�The To-Do List
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	The To-Do list allows you to keep a running list of things to do, and things completed.  The list contains space for a short description of the item, the date and time it was started, and the date and time it was completed.  Once completed, items can be automatically removed after they reach a certain age.  The entire list may also be printed. 



	When you press ALT 5 from anywhere within MultiWorks, you will enter the To-Do List mode.  The To-Do List consists of two main parts.  The first is the 'Current Listing' or unfinished jobs section.  The second section is the 'History Section' and contains all the items that you have marked as complete.  Press F10 to enter the History section, or press F9 to return to the Current section. 





Editing the To-Do List



	To enter or revise an item, simple position the cursor over top of the description and start typing.  To add a new item, move the cursor down beyond the bottom of the list.  You will be unable to edit anything but the item description, as that the dates and times are entered automatically.  To remove an item entirely, select it, and press the DELete key. 



MOUSE - Click within the To-Do item area to edit any of the entires, or click on the up/down arrow or the page up/down symbols to move through the list. 







Marking an Item as Complete



	In the Current List mode, place the cursor anywhere on the same line of the desired item and press the END key.  The item's End date and time will be filled in automatically, and the item will be sent to the History List.  In the History List, pressing the END key will cause the selected item to be sent back to the Current List, and have it's end date and time cleared. 





Printing the To-Do List



	When you press the F5 key and select an output device, you will have the option of printing the Entire list, the Current Items only, or the History only.  Items will be printed in the order they were entered.  Items that have been completed will be marked as 'Done'. 





Deleting Completed Items



	Once an item has been marked as complete, it is placed in the history file.  As that this file could grow to an unmanageable and unnecessary size, MultiWorks allows you the option to have very old items deleted automatically.  The amount of time that a completed item will remain in the history file, called the retention period, is controlled in the Maintenance screen, under the Misc Menu (F5).  The retention period is measured in units of days, and may range from 1 to 9999.  If you select a retention period of zero (0) old items will remain in the history file forever. 



�The Word Processor



	The Word Processor is an application that allows you to enter, edit and format a text document before it is actually printed.  The document can be stored (saved) for future use or modification.  When entering text, word processors allow you to delete mistyped characters or words and enter spacing (horizontal and vertical).  While editing, blocks of text can be copied or deleted, and words or phrases can be searched for and/or deleted.  And finally the document can be formatted by enhancing the output quality of the letters (printer permitting) by making them Bold, or Italic, or Underlined, etc, as well as adding page breaks in the proper positions.  



	The MultiWorks Word Processor offers you the ability to easily compose and edit documents, letters, memos or notes, of almost unlimited size (the average 640K system with a harddrive, can edit files approximately 10 megabytes in size).  The Word Processor contains some of the more common word processing features such as copying and deleting blocks, search and replace, page, paragraph and character formatting.  
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The Parts of the Word Processor



	The Word Processor display can be divided into two main areas, the Command/Status bar at the top and the Edit area at the bottom.  The Edit area is fairly self-explanatory, being the area that your document is displayed and edited in.  The Command/Status area consists of a menu bar, a status bar, a mouse bar and a tab bar.  Explanations for each follow.  The first line is the Menu bar which contains the names and function keys for each of the major menus.  The second, the Status bar, shows information such as Insert Mode, Current Filename and Row and Column.  The third line the Mouse bar allows mouse users to quickly select commands such for character typeface control, and cursor/page movement. See The Mouse Bar for a full description.  The Fourth and final line displays the current tab stops. 





�Common Editing Keys



	The following keys perform special functions within the word processor. 



Left Arrow   	- 	Moves the cursor one character to the left 

Right Arrow  	- 	Moves the cursor one character to the right 

Up Arrow     	- 	Moves the cursor one character up 

Down Arrow   	- 	Moves the cursor one character down 

INSert       	- 	Toggles the insert mode off and on 

ENTER        	- 	When INSert is on, it moves everything after the cursor down one line.  When INSert is off, it moves the 		cursor to the beginning of the next line.  

TAB          	- 	When INSert is on, inserts 5 spaces in front of the 	cursor and moves the cursor ahead 5 characters.  When 		INSert is off, moves the cursor 5 characters ahead.  

BACKSPACE	- 	Erases the character to the left of the cursor, and moves the cursor one character to the left. (also pulls 			any characters to the right of the cursor to fill in  the gap left by the erased character.) 

DELete       	- 	Erases the character to the right of the cursor, and 	pulls any characters remaining on the right of the cursor 		to the left. 



MOUSE - Point anywhere in the page currently being displayed, and click, and the cursor will move to that position.



ALT A 	- 	Replace All matching words/phrases (that match search word/phrase)

ALT B 	- 	Bold Characters

ALT E 	- 	Start Text Block 

ALT F 	- 	End Text Block 

ALT G 	-	Move Text Block 

ALT H 	- 	Centre Current Line 

ALT I 	- 	Italic Characters

ALT K 	- 	Delete Text Block 

ALT L 	- 	Delete Current Line 

ALT M 	- 	Replace Some matching words/phrases (that match search word/phrase)

ALT N 	- 	Normal Characters 

ALT O 	- 	Clear Text Buffer 

ALT P 	- 	Compressed Characters

ALT Q 	- 	Superscript Characters

ALT R 	- 	Replace One matching word/phrase (that matches the search word/phrase)

ALT S 	- 	Search for word/phrase

ALT T 	- 	Import Text Block 

ALT U 	- 	Underline Characters

ALT V 	- 	Copy Text Block 

ALT W 	-	Wide Characters

ALT X 	- 	Export Text Block 

ALT Y 	- 	Insert Page Number 

ALT Z 	- 	Subscript Characters

ALT + 	- 	Search Next matching word/phrase (that matches the search 	word/phrase)

ALT -	- 	Search Prev matching word/phrase (that matches the search  word/phrase)



ALT 1 	- 	Move to the next Segment in a large text file

ALT 2 	- 	Move to the previous Segment in a large text file



CTRL B 	- 	Reformat Paragraph

CTRL O 	- 	Insert Field Names for mail merge

CTRL T 	- 	Edit TABs





�The Mouse Bar
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	The Mouse Bar (fourth from the top of the screen) is a line that contains a variety of symbols and commands, designed exclusively for mouse use.  Starting from the left, the command symbols are Line up, Screen Up, Page Up, Segment -1 and Top of Document.  Clicking on any of these will perform that function.  The commands in the middle of the line represent : Fnt(font) Bld(bold), Itl(Italic), Nrm(Normal), Cmp(Compressed), Sup(SuperScript), Und(Underling), Wde(Wide), Sub(SubScript), VPg(Variable Page Break), PPg(Permanent Page Break), Pg#(Page Number).  Clicking on any of these commands will cause the appropriate control character to be inserted into the document at the current cursor location.  The final group are Bottom of Document, Segment +1, Page Down, Screen Down, Line Down. 





Editing a document



	Once you are in the word processor itself, you may edit or add to the document as often as you wish.  Use the cursor keys to move around one character/line at a time, or the Pageup/PageDown to jump a page at a time.  Pressing the INSert key will toggle between insert and overwrite modes.  The ENTER key will cause a new line to be inserted after the cursor. 





Loading a new Document



	To load a new document into the word processor, press the F2 key, and select 'Load Document'.  This will invoke the File Selector and allow you to select a new document.  Please keep in mind that the document you were editing will be wiped from memory, and any changes made since the last time it was saved will be lost.  When you start MultiWorks directly from DOS you have another way of loading a file.  Type 'MW' (for MultiWorks), followed by a space and a 'W' (for Word Processor).  Now enter another space and type in the name of the file that you want to edit.  When you press ENTER, MultiWorks 15 will load, the Word processor will execute and the file you selected will be loaded automatically. 





Loading Large Files



	The Word Processor has the potential to load files that are up to 20 megabytes (20,000,000 bytes) in length in an average 640K machine.  To do this, the file is broken in small chunks, called segments.  These segments are then accessed one by one.  The default size of each segment is approximately 10,000 bytes or characters (this may vary as that lines are not broken in the middle).  Up to 999 segments can be created for any one file.  To increase or decrease the segment size, and thereby the maximum size of the file to be edited, modify the Word Processor line in the Maintenance Screen. 



	File segmenting is very powerful and opens the doors to many new editing possibilities, but it does come with a price.  Operations such as Saving, Printing, Searching and Replacing all work exactly the same with segmented files as they do with non-segmented ones.  The main difficulty with a segmented file is the need to manually step between each segment.  This can be accomplished with ALT 1 and ALT 2 as well as the Segment Menu (F10).  ALT 1 moves you to the next segment, ALT 2 brings you to the previous segment.  F10 brings up the Segment menu and allows you to go directly to any segment. 



	In order for the file segmenting to work properly, your system must contain at least as much free disk space as the desired file takes up.  The file you are editing should also be saved and then re-loaded every time you make major changes to its size. 





Importing / Exporting Text Files



	Under the File Menu (F2) are the 'Import from Clipboard' and 'Export to Clipboard options'.  Keep in mind that Importing from the Clipboard erases the current document.  See "The Clipboard" for more information. 











Saving a Document
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	There are three ways to save your document.  The first, accessed by pressing the F3 key (or by choosing 'Save' from the File pull down menu), saves the document with the current filename.  (If a filename has not yet been entered for the document, you will be prompted to enter one.) The second method, invoked by pressing F4 (or choosing 'Save As' from the File pull down menu), prompts you for the filename and then saves the document with that name.  The third method, 'Save Text' is only available from the File menu, and saves the current document without any formatting settings at all (pure text).  See 'Document Defaults' below for more information.  After any of the save operations, you may continue editing where you left off. 





Automatic Document  Saving



	The  Autosave features allows the automatic saving of your document a regular (user defined) intervals.  When this interval is reached, the system will pause momentarily while saving, and then allow you to resume.  Use the Maintenance Screen to turn this feature on and off, as well as to set the time interval between saves.





Automatic Document Backup



	As a safety measure, you can have the system automatically backup the file currently being edited.  To turn this feature on and off, use the Maintenance Screen.  Keep in mind that you will need as much free disk space as the original file took up, to save the backup.  





Block Manipulation
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	Sometimes you may want to delete or copy large chunks of your text without having to spend the time re-keying or holding down the delete/backspace key.  All of the block functions are available from the Block pull-down menu.  These block handling capabilities are as follows: 





Defining the Block



        	Position the cursor at the beginning of the desired block.  Press F6 and select "Start Block", or type ALT E to begin the block.  Now move the cursor to the end of the desired block of text.  Select "End Block" from the Block pull-down menu, (or by pressing ALT F), to mark the end of your block.  If you are using a segmented file, the block definition my not extend beyond the current segment. 





�Copying the Block



	After defining your block of text, move the cursor to the position where you want the text to be copied to.  Choose "Copy Block" from the block pull-down menu, (or type ALT V) and the defined block will be copied to the new location. The old block will be left unchanged. 





Moving the Block



	After defining your block of text, move the cursor to the position you want the text to be moved to.  Choose "Move Block" from the block pull-down menu, (or type ALT G) and the defined block will be moved to the new location.  If you are using a segmented file, you may not move the block to another segment. 





Deleting the Block



	After defining the block of text to be deleted, simply select "Delete Block" from the Block pull-down menu, or type ALT K.  The block will be deleted and the screen updated.  If you are using a segmented file, you may not delete a block that has been defined in another segment. 





Importing a Text Block (file)



	To append another document or a part of another document, select 'Import Block' from the Block pull down menu, (or press ALT T).  Choose the file to import with the File Selector.  The text contained in that file will be inserted at the present cursor location.  





Exporting a Text Block (file)



	To write part of the current document to disk, first select the block with 'Start' and 'End Block', and then select 'Export Block' from the Block pull down menu, or by pressing ALT X. Enter the desired filename, and the selected portion of the document will be written to disk, leaving the document unchanged. 





Importing a Text Block (Clipboard)



	This function acts much like the (file) Block Import, except that you do not have to choose a file to import.  Instead, the contents of the Clipboard (provided they are less than the current segment size) are imported as a block. 





Exporting a Text Block (Clipboard)



	This function performs exactly the same as the (file) Block Export.  The main difference is that you are not prompted to enter a filename.  The contents of the marked block are automatically written to the Clipboard. 





Clearing the Block Marks



	Before defining a new block, it's a good practice to remove the (invisible) marks left on the old one.  Simply select "Clear Buffer" from the block pull- down menu, or type ALT O.  





�Reformatting Paragraphs



	After extensive editing, a paragraph may appear quite ragged.  In order to restore the paragraph to a neat and orderly shape, use the 'Reformat Paragraph' option from the Block pull down menu.  This option rebuilds the paragraph by filling incomplete lines from the lines below them.  You can also activate the paragraph reformat by typing CTRL B.  Please note that the paragraph reformat only works with properly formatted paragraphs.  A properly formatted paragraph is one that was ends with a Carriage Return.  Paragraphs made up of different lines that simply happen to be in close proximity, cannot be reformatted. 





Search and Replace
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	In a large document, it is often difficult to locate a specific word or phrase.  Using the search and replace functions in the MultiWorks Word Processor will help you find text, and optionally replace it.  

Searching for text



	Select "Search" from the search menu, or press ALT S.  Type in the word or phrase that you are looking from and press the ENTER key.  If found, the cursor will be placed at the beginning of search text.    





Searching again



	To search for the next occurrence of the word or phrase, select "Search Next" from the search menu, or press ALT + (actually, you will be pressing ALT =, but since the + sign is right above it, and the SHIFT key status does not matter, it will be referred to as ALT +).  If found, the line containing the next occurrence of the text will be displayed at the top of the screen, and the cursor will be placed underneath the first letter.  





Searching Backward



	To search for the previous occurrence of the word or phrase, select "Search Prev" from the search menu, or press ALT -.  If found, the cursor will be placed at the beginning of search text. 





Replacing Text Once



	Once the desired text has been found, you may want to exchange it for some other text.  Selecting "Replace One" from the search menu, or pressing ALT R, will display a prompt for the replacement text.  Once you enter the text and press ENTER, the word processor will replace the next occurrence of the searched text with the text you just entered.  





Replacing Text Several Times



	If you need to replace some, but not all the occurrences of searched text, select "Replace Some" from the search menu, or press ALT M.  Again, you will be prompted for the replacement text.  You will also be prompted for the number of occurrences to replace.  When you enter both, the Word Processor will execute the specified number of replacements starting from your current position in the document.  





�Replacing All Text



	To replace ALL occurrences of the search text, select "Replace ALL" from the search menu, or press ALT A.  Once again you will be prompted to enter the replacement text.  Once you have done this, the Word Processor will replace ALL occurrences of the text starting from the beginning of the document.  





Case Sensitive/Ignore Case



	The Final option in the Search menu has two states, either 'Case Sensitive' or 'Ignore Case'.  (Selecting the option in either state will cause it to be toggled to the other.)  This option controls the manner in which searches are conducted.  'Case Sensitive' requires that the Search text be exactly the same as the text in the document before a match is found.  'Ignore Case' allows matches to be found, no matter what the case of each either the document text or the search text is. 





Special Formatting



	The print quality of a document can be enhanced or modified in several ways.  The first way is by modifying the print typeface attributes.  Typeface attributes include styles such as Bold, Underline and Italic.  The second way to modify the appearance is by changing the actual Font (Helvetica, Times, Courier, NLQ, and Draft are a few of the more common fonts) used to form the printed characters.  Most printers support different typeface attributes, but not all support the use of multiple fonts.  Please be sure to know your printer's capabilities before attempting to use either method. 



	To change the Typeface attribute the printed text (provided your printer is supported), use the following keystrokes ahead of the text to be modified.  Be warned, unless you turn these attributes off, the remaining portion of the document will be printed in that typeface.  To turn an attribute off, use the ALT N keystroke (normal) after the text.  





Keystroke	Effect 



ALT N		Normal Text 

ALT B		Bold Text 

ALT U		Underline Text

ALT I 		Italic Text

ALT A		Superscript Text 

ALT Z 		Subscript Text 

ALT C 		Compressed Text 

ALT W		Wide Text



	To change the font currently being printed (provided your printer is capable), insert the Font character "ƒ" by selecting 'New Font' from the Style pull down menu, clicking on 'Fnt' in the mouse bar, or pressing CTRL F.  Directly after the font symbol must come the font number to be used.  This number can be between 1 and 99 and must indicate a valid font description in the printer driver.  Once a font has been 'turned on' it stays on until switched to another.  Please see the Maintenance chapter for more information on fonts and printer codes. 





Adding a new Print Driver



	If your printer is not supported (see choosing a printer), you can build your own printer driver by adding a new record to the database file "DRIVERS.DBF", and then inserting the appropriate control codes from your printer manual.  The best way to do so, is to use the Edit Driver function from the maintenance screen.  Please note that codes must be entered as their ASCII equivalent, ie: as characters.  See the existing drivers for examples.  The ESC (chr(27)) character that precedes most printer commands can be entered by using an '|' anywhere within the printer code. 



Please Note : Previous versions of MultiWorks 15 used the "E" character to represent ESCape.  Due to the fact that the "E" character is sometimes used within an actual code, it has been changed. 





Page Breaks
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	A page break is simply the point in the document where the printer is told to eject the current page, and start again at the top of the next one.  There are four ways to insert page breaks.  The first three insert 'Variable' page breaks, which are page breaks that can be moved or deleted automatically by the program.  The fourth is a 'Permanent' break, which must be inserted manually, and will not be moved automatically. 



	The first method (the manual method) is to press CONTROL P at each point in the document that you desire a page break to be.  This option creates variable page breaks.                          



	The second method (fixed) is to choose the 'Insert Page Breaks' option from the Page menu (F8), and use the Fixed option.  This option first deletes all current page breaks and then adds new ones every x lines.  'X' is the number of lines specified with the "Set Page Length" option (in the Page Menu (F8).  This option creates variable page breaks. 



	The third method (smart) is to choose the 'Insert Page Breaks' option from the Page menu (F8), and use the Smart option.  This option first deletes all current page breaks and then examines the x'th line 'X' is the number of lines specified with the "Set Page Length" option (in the Page Menu (F8).  If this line turns out to be in the middle of a paragraph, MultiWorks will search backwards, and place the page break at the top of that paragraph.  It will then count another x lines and again avoid breaking a paragraph.  MultiWorks will continue doing this until the entire document is properly formatted.  This option creates variable page breaks. 







	The fourth method (permanent) is to press CONTROL Q at the point in the document that you wish a page break to be.  As that this type of page break cannot be automatically deleted or moved, it is most useful as a chapter or section break.  This option create permanent page breaks. 





Removing Page Breaks



	You may remove all page breaks without adding new ones by using the 'Remove page breaks' option from the Page menu (F8).  Select 'Variable' to remove only the variable page breaks, 'Permanent' to remove just the permanent ones, or 'All' to remove all page breaks. 





Headers and Footers



�EMBED PBrush \s  \* mergeformat���



	Headers and Footers are single lines of text that go at the very top (Headers) and/or very bottom (Footers) of the page.  Once a header/footer is defined and page breaks are set, every time the document is printed, the header/footer will be printed on each page.  Headers and Footers can contain any of the normal typeface control characters for bold, underline, etc as well as page numbers.  



�	In order for headers and footers to work properly, you must specify certain information.  Firstly, the Word Processor needs to know the maximum number of lines that your printer paper can hold.  In most cases a letter size (8.5" x 11") can hold 66, while a legal sized sheet (8.5" x 14") can hold 84 lines.  You can set this using the "Paper Size" option from the Page menu (F8).  If you are using something other than Letter or Legal sized paper, select the "User Defined" option and enter the total number of lines.  Now that you have defined the paper size, you must also define the page size (actual number of lines to be printed).  Keep in mind that headers and footers each take up two lines (one text, one space), for a total of 4.  If for example, you are using letter sized paper, (66 lines) and have both a header and a footer defined, you would not want your page size to be more than 62 (66-4).  But for neatness' sake, I would recommend a page length of only 60 lines in this case. Once you have set both the paper size and the page length, set your page breaks (from the Page menu (F8)). 



	In order to define a Header or a Footer, first type in the line that you wish to be the header or footer.  Make sure that it is exactly the way you want to be, and then select the Page menu (F8).  Select "Make Header" for headers, or "Make Footer" for footers and press ENTER.  After selecting either of the Make options, you have the option to make that header or footer the default.  If you plan to create and print many similar documents, you might find this option a good idea.  When the document is saved again, any header or footer lines will be automatically saved with it. 



Please Note:  Headers and Footers will only work if the document has been paged (set page breaks) properly before it is printed. 





Mail Merge



	Mail Merge is a process that allows you to automatically insert information from the address book into the document you are printing.  This allows you to easily create form letters or other documents.  The merging process only occurs while printing, your document is not affected at all. 



	Merge information is extracted from the Address Book.  Each Address Book entry is divided into sections called fields (it's a database file).  When merging, only information in the specified fields is used. 



	To set up a document for Mail Merge, first decide what information should be inserted, and where it should go.  Position the cursor at the appropriate place and press 'Control O'.  A menu of possible field names will appear.  Select one and press ENTER and it will be inserted at the current cursor position.  Listed below are the possible field names, and what they contain.  Items marked 'N/A' contain no meaningful information and should not be used. 



NAME		The personal or company name

ADDR1		The first line of address information

ADDR2		The second line of address information

ADDR3		The third line of address information

CODE		The postal/zip code

TAG 		N/A

PHONE	Business phone number

PHONE2	Home phone number

CONTACT	Contact Name

DELETED	N/A

FAX  		Fax phone number

EXTENSION	Extension for business phone number

MEMO 		N/A

GROUP	The group that this entry belongs to

TITLE		The Contact Title



	To perform the Mail Merge, select 'Mail Merge Print' from the print pull down menu.  You will be asked to select the range of address entries to print.  'Selected' entries are those that have the 'Print' box in the Address Book turned on, 'Group' allows you to select a group to print, and 'All' prints all the entries in the Address Book. 



	You may enter any of these field names manually, as long as you type them in uppercase, and bracket each with less-than '<' and greater-than '>' signs.  Any ordinary text within your document that contains the '<>' signs will be ignored. 





�Page Numbers



	If your document contains page breaks, you can use the ALT Y key stroke to insert a page number.  Simply position the cursor where you want the page number to appear, and press ALT Y.  No matter where on the page you place it, or how many times you place them, the page number control character will cause the current page number to be printed in that position.  Each page however must have it's own page number control character, unless you place the page number within the header or footer line. 





Centering and Justifying Lines



�EMBED PBrush \s  \* mergeformat���



	To centre the current line, position the cursor anywhere along it, and press ALT H.  To block the contents of a line to the left or right, again position the cursor on the desired line, and the press ALT J.  Select "R" for right blocking, or "L" for left blocking. 

Tabs
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	Tabs allow the cursor to be moved forward or backward a predefined amount of space.  The default space is 5 characters, but these spaces may be easily changed to your liking.  Press the Tab key to move forward, or press Shift & Tab together to move backwards. 



	To change the tab spacing, select the Options Sub Menu through the Page menu (F8) and select 'Set Tabs'.  When you select 'Set Tabs', you have two choices, firstly to restore the default tabs 'R' and secondly to edit the existing ones.  If you select 'Restore', the current tab settings will be replaced with the default tab settings.  If you select 'Edit', you will be able to modify the existing tab settings in your document.  To do so, simply place a period where ever you want a tab stop to be.  The placement of any other character in the line will be ignored.  Once you are finished setting the tabs, press ENTER and you will have the option of making this new tab setting the default setting. 





Printing a Document
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	To print, press the F5 key, and select "Document Print" from the File pull down menu.  You will be asked to select number of copies, starting and ending page numbers to print.  Make your selections and press ENTER or PAGEDOWN.  To change printers, see the Maintenance Screen and "Select Printer".  





Page Orientation



	When printing a document, there are two different page orientations to consider; Portrait and Landscape.  Portrait mode with an 8.5" x 11" paper size allows for 80 columns across, and 66 lines down.  Landscape mode with the same size of paper allows for 110 columns across, and 51 down.  Both of these examples assume a character size of 10 cpi.  Unfortunately, the Landscape mode is only available when printing to an HP Laserjet.  To select Landscape, toggle the Portrait option from the Page menu (F8).  To change back to Portrait mode, toggle the Landscape option from the Page menu (F8).  When Landscape mode is selected, the page width will automatically be changed to 109 columns, and the page length, and paper size will also be changed accordingly.  The default page orientation is Portrait.  



Locating Words in the Dictionary



	Pressing F8 will bring up the Page menu, select 'Options Sub Menu' will bring up the Options menu.  Selecting "Locate Word" will allow you to search for a word from the dictionary.  To use, simply enter as much of the word as you know, and press ENTER.  A dictionary search window will appear with the closest match at the top.  Use the cursor keys to scroll through the list until the desired word is highlighted.  Pressing ENTER will cause the highlighted word to be inserted at the present cursor location.   Press ESC to avoid that.  If the word matches one in the dictionary exactly, it will indicated by a 'correct' on top of the dictionary search window.  





Document Statistics



	Selecting the Options Sub Menu through the Page Menu (F8) and selecting "Display Doc Stats" will show you the size of the current document in bytes, the approximate number of words, and the number of sentences.  





Setting the Page Length



	Under the Page menu (F8), is an option for setting the number of lines per page "Set Page Length".  The default page length is set to 66 lines, the appropriate number for a 8.5" x 11" (letter) sheet of paper.  Legal size paper (8.5" x 14") requires 84 lines per page.  Since most printers print 6 lines per vertical inch, you can easily calculate other odd size of paper.  The number that you set with this option determines the number of lines between each page break.  





Setting the Document Width



	Under the Page Menu (F8), use the "Change Page Width" option to increase or decrease the width of the page.  Valid sizes are between 10 and 250 characters wide.  The default size is 79 characters.  This information is saved with the document file. 





Setting the Print Margins



	Under the Page menu (F8), use the "Set Left Margin" option to add a left margin when printing.  This margin can range from 0 to 99 spaces. 



	Also under the Page menu, you can set the Top margin with the 'Set Top Margin' option.  The margin value can range between 0 and the length of the page. 





Setting the Line Spacing



	Again under the Page Menu (F8), is the option 'Set Line Spacing'.  This option allows you to adjust the vertical spacing in the printed output.  A value of 1 produces normal output; one line of text for each line on the page.  A value of 2 produces double spaced output, or one line of text for every two lines on the page.  A value of 0, prints the entire document on one line, and should not normally be used.  The line spacing value can range from 0 to 99. 





Document Defaults



	The last four document settings (page length, document width, print margin, line spacing), as well as header, footer and tab information are automatically saved with each document.  This unfortunately makes the standard 'save' function of the word processor unsuitable for text only operations such as batch file creation.  However there is an option under the File menu 'Save Text' which allows the current file to be saved without any of the formatting settings. 





�Aborting the edit



	Press the ESC key to return to MultiWorks main menu without saving the current document.  If the document has been changed since the last save you will be prompted to Save, Continue or Exit.  Remember exiting without saving will destroy any changes made to the document since the last save.  





Erasing the Document



	At any time you can erase the entire contents of memory by selecting 'Erase Document' from the File pull down menu.  This will not affect any documents already saved onto disk, but will mean that you lose any changes you have made, but not saved. 





Last Document Autoload



	In order to make jumping between the different sections of MultiWorks 15, easier and less time consuming, a feature called File Autoload has been implemented.  In the Word Processor, this feature ensures that the file you are currently editing when you exit the Word processor is automatically reloaded the next time you re-enter it.  This allows you to use the different features of MultiWorks without having to worry about constantly reloading your current file.  When you choose Save or Save as, the filename and directory information will be saved as the next Autoload file.  When you choose Erase Document, the information will be cleared, and the next time you enter the Word Processor, you will be starting from scratch.  Loading a file from the command prompt overrides the Autoload feature.  This feature is also present in both the Spreadsheet and the Database. 

�The Spreadsheet



	The Spreadsheet is an application that allows the user to perform mathematical operations upon rows, columns or single figures.  A spreadsheet can reference the totals from one operation and build them into the calculations for another.  The spreadsheet can also perform calculations based upon a user-defined formula.  The spreadsheet is laid out in a grid formation, each space of which can hold a numeric figure, a character label or a formula.  Each of these spaces is called a 'Cell'.  The grid has two axes, x and y, or columns and rows.  'Columns and Rows' is the most common name for the spreadsheet axes.  Columns are referenced by a letter (starting with A), starting from the left and working to the right.  Rows are referenced by number, starting with 1 at the top and increasing downward.  
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	To reference a cell in a calculation, the spreadsheet expects the address format to be ColumnRow.  For example: A10 (the leftmost column and the tenth row down) or G19 (the seventh column from the left and the nineteenth row down) 



	Ranges of cells may also be referenced, either vertically or horizontally.  To reference a range, use the address for the top or left cell, followed by a colon ':', followed by the reference of the bottom or right cell.  For example: A1:A30 or G12:Y12.  





	With sufficient memory and hard drive space, the MultiWorks Spreadsheet can use a file of 702 columns by 10,000 rows (a total of over seven million cells).  To increase or decrease the number of columns, set the Max Columns figure in the Maintenance screen, and then create a new (blank) spreadsheet (F4).  New rows can be added automatically, or upon demand. 





Notes on Spreadsheet Widths



	Like most other spreadsheets available on the market, the MultiWorks 15 Spreadsheet is limited by memory.  But because it stores the spreadsheet files partially on disk and partially in RAM, memory is less of a problem.  In fact, you should be able to use up the total number of rows without any problems.  The most common cause of trouble is with a spreadsheet file that is too wide (too many columns) for the amount of free memory.  You may have to experiment with your system to discover a happy medium between enough room on the spreadsheet, and enough free memory to use it effectively. 





Spreadsheet Files



	The spreadsheet uses four different kinds of files.  The first, is the spreadsheet file itself and has an extender of '.SHT'.  The second, the formula file has the extender '.FMT'.  The third, is an index file for the formula file and uses the extender '.NTX'.  The final file type is optional, and only exists if there are graphs to go along with the spreadsheet.  It uses the file extender '.GRF'. 





�Moving Around in the Spreadsheet



	As the spreadsheet is actually much larger than the part that can be displayed on the screen, only a relatively small part is seen at any one time.  The most common analogy is that the computer's monitor is a 'window' looking out onto the spreadsheet.  You can move this window to display different parts of the spreadsheet. 



	To move from cell to cell use the cursor arrow keys.  To move a page at a time (up or down) use the PAGEUP/PAGEDOWN keys.  To move to column A press CONTROL-HOME, to move to column Z press CONTROL-END.  To move to the leftmost column being displayed, press the HOME key, to move to the rightmost column being displayed, press the END key. 



MOUSE - Click on any cell currently displayed to move the cursor to that position. 





Loading a Spreadsheet



	Pressing F2 will invoke the File Selector and prompt you to pick a new file.   Only files that end with the spreadsheet extender (.SHT) will be displayed.   The new spreadsheet will replace the one currently in memory.  





Converting to and from Lotus(tm) Spreadsheet Files



	The MultiWorks spreadsheet allows you to read and write Lotus(tm) .WK1 compatable files with a short conversion process.



          To use a spreadsheet file created with Lotus(tm) version 2.01 through 2.4 (or any .WK1 compatible file), you must convert it to the MultiWorks spreadsheet format first.  To do so, select Convert from the File pull-down menu and select 'From' to convert from a Lotus(tm) spreadsheet file.  Choose the desired file with the File Selector, and it will be converted autmatically.  The original .WK1 file will not be changed, instead, a new file will be created using the same filename, and the '.SHT' extension.  All functions not supported by the Multiworks spreadsheet will be replaced with the '@ERR()' function.



	To convert an existing MultiWorks spreadsheet file to the Lotus(tm) format, first load it into the spreadsheet.  The select Convert from the File pull down menu and select 'To' to convert to Lotus(tm) format.   The converted file will be saved using the same filename as the MultiWorks file.





Please Note:	Only functions and formula formats supported by the MultiWorks spreadsheet can be translated to and 		from the Lotus(tm) format.  Please be sure when importing a .WK1 file that it contains no unknown 			functions and no illegal formula formats.  See the section in this manual on functions for a complete 			descriprion of legal formulas and formats.





Importing / Exporting Spreadsheet Files



	Under the File Menu (F2) are the 'Import from Clipboard' and 'Export to Clipboard' options.  When Importing, you may choose to have the imported data Replace the existing sheet, or be appended to the bottom of it.  You may also choose whether or not to reformat the column widths to match the format of the imported data. 





Entering Information
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	To enter a value or text into a cell, simply position the cursor over the desired cell and then start keying.  Press ENTER when complete.  To enter a formula, position the cursor over the desired cell and press the F3 key, or the @ symbol.  You will be able to enter your formula on this line (up to 200 characters).  Press ENTER when complete. 

Entering Formulas



	A formula is a mathematical equation that you create to solve a problem.  It can be very simple: '1+2' or very complex '@rnd(a1,2)+10/23*12'.  To create a formula, you must format the elements of the equation properly.   The format is 'OperationValue'.  'Value' is the number to be calculated, 'Operation' refers to what effect this number will have on the current total. If the first element in the equation lacks an operation, it is assumed to be addition '+' ... all following elements in the formula must be preceded by an operation.  The calculation is performed upon the first element, and carried in sequence to the last.  As that no order of operation is followed by the program, it is strictly up to the creator of the equation. 



	To enter a formula in the spreadsheet, you must do one of three things.  Either press the F3 key (edit formula) and then type it in, or press either the "@, +, -, *, or /" key followed by the rest of the formula. 



	For instance, to multiply the value in cell A10 by 33, you would enter the following elements: 



   +a10*33 



   +A10		adds the contents of the cell A10 to the current total 

   *33		multiplies the current total by 33 





	Assume that each formula begins with a total of 0.  Therefore, the first element performs an operation upon that total.  The second element performs an operation upon the resultant total, and so on for the entire formula. 



	In the above example, the initial total "0" has the value found in cell A10 added to it.  The total (now the same as the value in A10) is then multiplied by 33.  Valid operators are +(addition) -(subtraction) *(multiplication) /(division) and ^(square) either cell references or numbers (positive, negative or decimal).  





Examples: 



   +A1	add the contents of the cell A1 

   -A1	subtract the contents of the cell A1 

   *A1	multiply by the contents of the cell A1 

   /A1	divide by the contents of the cell A1 

   ^A1	add the square of the contents of the cell A1 

   +10	add 10 

   -10	subtract 10 

   *10	multiply by 10 

   /10 	divide by 10 

   ^10 	add the square of 10 





Functions



	Functions are built-in formulas for calculating specific equations.  They all begin with the '@' (at) symbol and have a three letter name.  Functions require one, two or three input values, separated by a comma.  The values are surrounded by curved brackets.  These values may be cell references (of cells that contain valid numeric values), actual numeric values, or numeric equations.   Each function may be preceded by an operator (+ - * / ^). 



	Functions range from simple math functions that calculate square and square root operations, to powerful financial functions that can help you determine the cost of buying a home. 





�Single Value Functions



 @abs(value)	--- 	The absolute (positive) value of 'value'.  Negative twelve for instance would be returned as 12.  				Positive twelve however would remain unchanged. 



 @exp(value)	--- 	Calculates the natural logarithm for 'value' 



 @log(value)	--- 	Converts 'value' to its natural logarithm 





 @int(value)	--- 	Returns the integer value of 'value' (truncates). The number returned lacks all digits after the decimal 			place.  No rounding of the returned value takes place at all. 

 

 @rdm(value)	--- 	Calculates a random integer between 1 and 'value'.  	Each time the cell is recalculated, this formula 			will return a new value. 



 @sqt(value)	--- 	Calculates the square root of 'value' 



 @sqr(value) 	--- 	Returns the square of 'value' (value can be cell references, numeric values, or numeric equations) 





Double Value Functions



 @rnd(value1,value2)	--- 	Rounds 'value1' to 'value2' decimal places.  	Any decimal number will be rounded off to the 				specified number of decimal  places.  Integers are not affected. 



 @mod(value1,value2) 	--- 	Returns the remainder from the division of 	value1' by 'value2'.  This function performs the 				division of value1 by value2 but returns only the remainder.  To determine the result of an 				actual division, simply create a formula that  divides value1 by value2. 



 (values can be cell references, numeric values, or numeric equations) 







Triple Value Functions



 @pmt(prin,int,term)	--- 	Calculates the value of each payment to pay off a loan of 'prin', with an interest rate of 'int' 				and 'term' payments.  If you were  interested in purchasing a house for 100,000 dollars, at an 				interest rate of 12% and wished to pay the entire amount off in 20 years, you can use the 					function to determine the size of each payment.  You would complete the formula as follows: 



 @pmt(100000,.12/12,12*20) 



	The first value; 100000 is the principal, or the buying price.  The second value, is the interest rate (12%) expressed as a decimal (.12) and divided by the number of interest periods per year (12) (the number of times the interest is compounded).  The third value is the number of payments per year (12) multiplied by the number of years in the term.  (You could simplify the second and third values by entering the actual figures directly, but the example is easier to follow). 





@pmt(100000,.12/12,12*20) would return a figure of $1101.086134 



	You now know that such a mortgage would cost $1,101.09 per month to pay off in twenty years. 





�@trm(pmt,int,fvl)  --- 	Calculates the number of 'pmt's necessary at the interest rate 'int' to return the value of 'fvl'.  With this 			function, you can calculate the number of payments 'pmt' at the interest rate of 'int' necessary to 				achieve a future value of 'fvl'. 



	For example, you wanted to purchase a new car outright.  The car's cost is $5000 (assume that inflation does not affect the price).  You can afford to put away $139.50 every month, and your savings account pays 7% interest compounded monthly.  You would fill in the function as follows: 





@trm(139.5,.07/12,5000) 



	This would return a figure of : 32.64 It would therefore take you 2 years and just over 8 and a half months to save up the correct amount. 



@pvl(pmt,int,term) --- 	Calculates the present value of an invested amount based upon 'term' amounts of 'pmt' invested at the 			interest rate 'int'. 



	For example: In the above example, after 18 months of saving you grow tired of it, and decide to by a motorcycle instead.  You need to know exactly how much money you have saved.  Using the function @PVL() you fill it in as follows: 



@pvl(139.5,.07/12,18) 



   	('pmt' is the monthly payment you have been making, 'int' is the interest rate that your bank has been paying divided by the number of compounding periods (12) and 'term' is the number of payments that have been made) 



Therefore after 18 months you have saved $2,377.10 





@fvl(pmt,int,term) --- 	Calculates the future value of an invested amount based upon 'term' amounts of 'pmt' invested at the 			interest rate 'int'. 



@ctm(int,fvl,pvl)  --- 	Calculates the number of compound interest periods 	necessary to increase the value ' pvl' to the value 			'fvl' with an interest rate of 'int'.  With this function, you can 	calculate how long it will take a sum 			invested at a particular interest rate to increase to the desired value. 



(values can be cell references, numeric values, or numeric equations) 





Range Functions



	There are also two formulas that calculate results based upon a range of values.  They are; @SUM(range) - sum of the range, and @AVG(range) - (mean) average of range.  The format for entering a range is: cell reference, colon, cell reference (A1:B10, C10:C20, A4:F4, etc). 



+@SUM(a1:a10) 	add the sum of all the values in the range A1:A10 -@AVG(b7:b20) subtract the average of all the values in the range B7:B20 





Recalculating Spreadsheet Totals



	Select Recalculate by pressing F10.  The speed of this operation depends upon the size and complexity of the spreadsheet.  Please note that calculated cells will be automatically reformatted to the current default format setting. 





�Graphing
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	The MultiWorks spreadsheet allows three different types of graphs to be created.  They are Bar, Point and Line.  



	To create a new graph, select 'Graphs' from the Options Pull down Menu (F8).  Select 'Create New' from the prompt, and then select the type of Graph you wish to create.  Now enter the cell addresses for one to three ranges of data.  Data ranges may be horizontal or vertical.  Once the graph has been displayed, press F5 to print it.  



	To load previously created graph, select 'Graphs' from the Options Pull down Menu (F8).  Select 'Load Existing' from the prompt, and then select the graph you wish to display. 



	You can save your graph for future use, by answering 'Yes' to the save prompt (appears after viewing the graph) and supplying a name.  There is no limit to the number of graphs you can define and save per spreadsheet. 





Marking a Cell Range



	To 'Copy', 'Move' or 'Delete' a range of Spreadsheet cells, you must first define a block or range of cells to act upon.  



	Position the cursor over a cell and press the ALT E key (or select 'START Range' from the Copy menu) to cause the coordinates of that cell to be marked as the beginning of the copy range (top left hand corner).  Position the cursor and then press the ALT F key (or select 'End Range' from the Copy menu) to mark the end of the copy range (bottom right).  





Copying a Cell Range



	To copy the marked range in a new location, first define the range, then position the cursor to the desired destination (top left) and press ALT V (or select 'Copy Range' from the Copy menu).  





Moving a Cell Range



	To move the marked range to a new location, first define the range, then position the cursor to the desired destination (top left) and press ALT G (or select Move Range from the Copy menu).  



Deleting a Cell Range



	To delete a marked range, first define the range, then press ALT K (or select 'Delete Range' from the Copy menu). 





�Importing a Cell Range



	Under the Copy menu is an option called 'Import Range'.  This option allows you to copy a range of cells from another spreadsheet, and insert them into the current spreadsheet.  To do so, first position the cursor to the location where you want the imported cells to be copied to.  Then press ALT R or select 'Import Range' from the Copy menu (F7) and select the source spreadsheet with the File Selector.  After selecting it, enter the range of cells to extract.  The cells will be extracted from the source spreadsheet (without affecting it at all) and copied into the current one. 





Static and Relative Mode Copying



	Normally, when copying a cell from place to place, any cell references inside that cell remain exactly as they were entered.  In many cases, this is a good idea, as the cells you are referencing do not move themselves.  Quite often though, you may want to write a formula that references cells in a relative manner.  



Example: 	You create a spreadsheet that contains 10 columns of figures, and write a formula at the bottom of the first column to sum that column and multiply the resulting total by 12.  If you then copied that formula using Static Mode copying, it would always total the original column, no matter where it (the formula) had been copied to.  If instead, you copy the formula using Relative Mode copying, the copied formula will be automatically changed to address its new position.  For example, copying the cell A12 containing '@SUM(a1:a10)' three columns to the right would change the formula to '@SUM(d1:d10)'. 



	To use Static Mode copying, select 'Static Mode' Copying from the Options pull down menu (F8).  To select 'Relative Mode' copying, select 'Relative Mode Copying' from the Options pull down menu (F8).  While Relative Mode is active, only the cell references written in lowercase will be modified.  Any written in uppercase will be considered to be permanently static, and remain unchanged.  



          The last mode used is always saved.





Deleting a Single Cell



	To delete a single cell, position the cursor over top of it, and press the DELete key. 





Deleting (Removing Rows)



	To delete the contents of an entire row, or range of rows, as well as removing them from the spreadsheet, select 'Remove Rows' from the Options menu.  Enter the range of rows to delete (ie 1:2, a10:a20, etc.). 





Deleting Entire Spreadsheets



	Select 'Erase Spreadsheet' from the File menu to erase an entire spreadsheet. 





Printing
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	Pressing the F5 key will allow you to Enter a print range.  Make sure that you are not trying to print a width wider than your printer can accommodate. 













Formatting Cell Values
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	In order to enhance the readability and quality of both output and on screen displays, a numeric cell may be formatted in one of several ways.  Formatting involves redisplaying the value in a way that can make it both easier to read, as well as provide information as to the nature of that particular figure. 



	To change the formatting of a single cell, simply place the cursor over top of the cell and choose 'Select Formatting' from the Options pull down menu, F8.  To change the formatting of a range of cells, select the range with ALT E and ALT F and then choose 'Select Formatting' from the Options pull down menu, F8.  

Select one of the seven formatting options; 



Right Justify     		- moves the value to the right hand side of the   cell

Left Justify      		- moves the value to the left hand side of the cell

Centre Justify    		- moves the value to the centre of the cell

Negative Bracket  	- places round brackets around a negative value

Dollar Value 		- inserts a leading $ sign, and inserts commas

Comma Value 		- inserts commas into the value

Unformatted		- returns the value to an unformatted state



	Some formatting settings such as Right Justify and Dollar Value may be combined in a single cell.  When formatting make sure (especially with Dollar and Comma values that there is enough room in the cell to accept the extra characters.  Calculated cells such as functions and formulas may also be formatted, but will lose their formatting when recalculated. 





Default Formatting



	To automatically format all values as they are input, select 'Set Default Format' from the Options pull down menu, F8.  Choose the desired format from the list and press Enter.  This setting will remain until you change it, or return to the MultiWorks main menu.  After setting the default format, cells that are calculated will be formatted to the default setting. 





Setting The Number of Decimal Places



	To change the number of decimal places used to display integer values, select 'Set Decimals' from the Options pull down menu.  The current setting will be displayed beside the option.  Be advised that changing this value can affect the accuracy of some totals. 





Enhancing the Printed Output Quality



	Like the Word Processor and the Database, you can specify the output typeface and font of the printed spreadsheet.  Press F9 to view the Style pull-down menu, or use the usual ALT key combinations to insert typeface control characters.  When inserting control characters, keep in mind that they will always be placed at the very beginning of the cell, forcing the remaining contents (unless blank) one space forward.  Also remember that a typeface or font control character placed in the same cell as a number will cause that number to be no longer treated as a numeric value.  Therefore it is advisable to place control characters in a cell positioned directly before, or at the end of the print row above the desired numeric cell. 





�Creating a New Spreadsheet



	Selecting 'Create New Spreadsheet' from the File menu will allow you to create a new spreadsheet file.  You will be prompted for the name for the new file.  Enter a filename of one to eight characters and press ENTER.  Answer 'Yes' to copy the data from the current spreadsheet to this new one, or 'No' to leave it blank.  A new spreadsheet and formula file will be created with the name you Entered.  To access this spreadsheet you must then LOAD it.  





Saving a Spreadsheet



	Spreadsheets are saved automatically every time a change is made.  





Adding Rows



	In order to save disk space, the spreadsheet file comes with only 1 row.  Rows are added automatically when you try to move beyond the current limit.  You might notice a slight delay in moving when a row is first added.  





Adding Multiple Rows

 

	Select 'Add Rows' from the Options menu to add more than one row at a time.  All new rows will be added to the bottom of the current spreadsheet.  Formulas that are moved down because of new rows inserted above them will not automatically be adjusted to reflect their new position.  To avoid this problem, always add new rows to the very bottom of the spreadsheet. 





Column Separators
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	You may choose to have columns separated by a vertical line.  Select 'Column Separators' or 'No Column Separators' from the Options menu. 





Modifying the Column Width



	To improve the appearance of your spreadsheet, to allow more information to fit onto one page, or to allow larger numbers to be Entered, you can change the width of each column.  To change the width of a column, first position the cursor in the column to be changed (the row does not matter).  Then select "Modify Column Width' from the Options menu, and Enter the new cell width (in characters) for the column.  Columns can range from 1 to 75 characters wide.  



Warning: 	Decreasing the size of a cell, may cause the loss of data within that cell.   Try to adjust the cell sizes for your spreadsheet before Entering any data. 





�Last Spreadsheet Autoload



	In order to make jumping between the different sections of MultiWorks 15, easier and less time consuming, a feature called File Autoload has been implemented.  In the Spreadsheet, this feature ensures that the file you are currently editing when you exit the Spreadsheet is automatically reloaded the next time you re-enter it.  This allows you to use the different features of MultiWorks without having to worry about constantly reloading your current file.  As the spreadsheet information is always saved automatically, the filename and directory information for the Autoload is always kept up to date. When you choose Clear Sheet, the information will be cleared, and the next time you enter the Spreadsheet, you will be starting from scratch. This feature is also present in both the Word Processor and the Database. 

�The Database



	The Database is simply a file structure specifically designed to contain an ordered group of information or data.  Most databases are structured exclusively for one set of data.  A database contains a user-defined structure of columns (called fields), grouped into rows (called records).  Each Field has its own distinct name by which it is referred to.  Each Record contains a group of fields (one of each).  This list of information may be manipulated and viewed in a multitude of ways.  It can be sorted in ascending or descending order by any field.  It can be searched, viewed and edited.  Included with the MultiWorks database is a report generator which allows the information in the database to be printed in whatever format you desire.  
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�Creating a Database
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	To create a new database structure, select the "Create New" option from the File menu (F2), and enter the name of the new database (a valid DOS filename).  



	Please Note : The database structure creation process does not add nor allow any data to be added to the database.  Instead, it simply creates a blank 'template' for data to be inserted into later.  See Browse and Edit for adding data. 



	A database structure consists of one or more fields.  Each field has four parameters.  The first one is the 'Field Name', which is a unique identifier or name for each particular record.  This name is use to reference the data in that particular field.  The second, the 'Field Type', is a single character C, N, L, D, or M (Character, Numeric, Logical, Date, or Memo).  This denotes what type of data can be entered in a particular field.  The third parameter is the Field Length, which is simply the number of characters or digits that can be contained in each field.  Valid values are 1 to 250.  The fourth and final parameter, "Dec" is for numeric records only.  It defines the number of decimal places, or places after the decimal point. 



	Enter all the information for each field, then press the Cursor Down key to move onto the next field description.  When complete, press the ESC key to return to the database menu.  You can use the DELete key to remove any record after you enter it.  Make sure you fill in all the necessary information; blank parameters will invalidate your database.  Also keep in mind that you may return later to modify this structure. 



	If you are unsure of how a database structure should look, load one of the database files that come with MultiWorks, and select "Modify Existing" from the File menu (F2).  Without changing anything, compare the database structure as shown in the modify mode to the appearance of the database in the Browse (F5) and Edit Modes (F6).  





Modifying an Existing Database



	To modify the structure of the current database, select the "Modify Existing" option from the File menu (F2).  This process is almost identical to the "Create New" option, except that part of the structure already exists.  You may add new fields to the bottom of the structure, or delete fields altogether (with the DELete key).  Any attribute of an existing field may be changed except for the Field Type attribute.  Keep in mind that gross changes to the structure, such as smaller field widths, and new field names could result in a loss of data. 





Loading a Database



	To load an existing database for use, select the "Load" option from the File menu (F2), and select the desired database from the File Selector.  





�Appending and Writing Text Files



	Under the File menu (F2) are two options 'Append from File' and 'Write to File'.  These options are not to be confused with the Clipboard (import/export).  The Append function allows you to append to the current database file from either a text file or another database file of identical structure.  The Write option allows you to write the current database file out to a text file.  To append, select the 'Append from File' option, and choose the file to append from.  To write, select the 'Write to File' option, and enter a filename for the new file to be created. 

Importing / Exporting Database Files



	Under the File Menu (F2) are the 'Import from Clipboard' and 'Export to Clipboard' options.  When importing, the current file will be closed, and a new one created to match the clipboard's format. 





Removing Deleted Records



	If a database has deleted records (pressing the DELete key on a specific record in Browse mode), they are not actually removed from the database.  To removed them permanently, select the "Pack Database".  Once a database has been packed, all previously deleted records are gone.  





Deleting All Records



	In some cases it is necessary to remove all the records from a database.  One way would be to DELete them all in the browse mode, and then "Pack Database" from the File menu.  A faster and easier method is to select the "Delete all Records" option from the File menu (F2).  



Warning! This option deletes and removes all records permanently!





Sorting a Database



	After you have entered some data, you might want to resort it into alphabetical order.  To do so, select the Sort menu (F3) and choose the order of the sort to be performed (ascending - alphabetical or descending - reverse alphabetical).  Then choose the field that is to be sorted on from the provided menu.  If you need to sort several fields, start with the field of least importance.  



Searching a Database



	If you are working with a large database is can often be difficult to find the information or data that you are looking for.  To make this task easier, a database search mode has been provided.  



	Before a search can begin, you must provide two items of information.  The first is the field to be searched (only one may be searched at a time).   Select the "Set Search Field" option from the Search menu (F4) and enter the appropriate fieldname.  The second item of information needed, is the actual information you are searching for.  Use the "Set Search Item" option from the Search menu (F4) to set it.  Now you can commence the search.  To search for an exact match of the Search Item, choose the "Search" option from the Search menu (F4).  This will look for a field that matches the entire Search Item exactly.  To search for a less exact match of the Search Item (for example; to look inside of the contents of the Search Field for the Search Item) select "Substring Search" from the Search Menu (F4).  



	When and if an item is found, the record pointer is moved to that record, and the information may be viewed or edited by using the Browse or Edit modes.   Selecting "Search" or "Substring Search" again, will cause the record pointer to be moved to the next occurrence (if any) of the matched information.  



Short cut keystrokes for searching are



ALT I 	- Choose Item

ALT F 	- Choose Field

ALT S 	- String Search

ALT U 	- Substring Search



The Browse Mode
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	The Browse Mode (F5) displays all the records and fields that match the current view settings.  If more records and/or fields exist than can be displayed at one time, the entire list may be scrolled left or right and up and down.  In this mode, only one record is displayed per horizontal list.  Trying to move past the end (down) of the database will cause a new record to be added to the end if it.  The DELete key toggles the delete status of the current record (to remove it permanently, use the "Pack Database" option from the File menu (F2)).  Across the top of the screen can be found statistics regarding the current cell and record. 



	To edit or add data to the record, simple position the cursor on top of the desired cell and type any character.  When complete, press ENTER. 



While in the Browse mode, the following special keys are active: 



End			- Move to the rightmost visible column (field)

Home			- Move to the leftmost visible column (field)

Control End		- Move to the last column (field) in the database

Control Home		- Move to the first column (field) in the database

Page Up		- Move up 20 records

Page Down		- Move down 20 records

Control Page Up	- Move to the top of the database

Control Page Down	- Move to the bottom of the database

DELete			- Toggle the delete status of the current record

INSert			- Adds a new blank record to then end of the database

ESC			- Return to the Database Menu



MOUSE - Point and click on any cell to move the cursor.  Click just outside of the first and last fields to scroll the display left or right. 





�The Edit Mode
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        	The Edit Mode (F6) displays all the records and fields that match the current view settings, one record at a time.  The format is one field per line, and one record at a time.  The records can be edited or paged through (page up/page down) one by one. 

	To modify a record, simply position the cursor and begin typing.  Press ENTER or cursor down when complete.  Press INSert to add a new record to the end of the database.  Pressing ESC exits the Edit Mode.  





Special Functions



	Under the Special menu (F7) are a variety of advanced database features.  Once understood properly, these features can make your database work a lot more efficiently.  All of these function require a database to be open.  Some of the function require a logical expression to determine which records are to be affected.  Please read the following definition of a Logical Expression Carefully. 



	A Logical Expression is actually a simple equation consisting of 3 parts.  Two values to be compared, and an operator to compare them by.  The first part is usually a field name.  (in the following examples use the database ADDRESS.DBF').  For example: 'NAME'.  The second part is a logical operator .  The third part is a constant value to compare against.  For example 'desk'. 



Valid Operators Are :



'='	EQUAL TO

'<>' 	NOT EQUAL TO

'<'  	LESS THAN

'>'  	GREATER THAN

'>=' 	GREATER THAN OR EQUAL TO

'<=' 	LESS THAN OR EQUAL TO

'!' 	NOT 

'$'  	WITHIN



	These three parts make up what is known as a logical equation.  The equation can evaluate to either true or false.  True means records are displayed, False means they are not.  The only limit, is that only values of the same data type may be compared, for example, you cannot set the filter to name = 4.  (In your mind, try appending an 'IF' to the beginning ... " IF name = 'desk' ") 





�	You may also use a variety of functions to adjust the values you are comparing.  They are as follows: 



len(STRING) 	- returns the length (in number of characters) of STRING

ltrim(STRING) 	- returns STRING with leading blanks removeds 

rtrim(STRING) 	- returns STRING with trailing blanks removed

val(STRING) 	- returns the numeric value of STRING

str(NUMBER) 	- returns NUMBER as a character value

substr(STRING,NUMBER1,NUMBER2) 

		- returns NUMBER2 characters of STRING starting with character  NUMBER1

chr(NUMBER) 	- returns the character value of NUMBER

asc(STRING) 	- returns the numeric value of character STRING

deleted()	- returns True if the current record has been deleted

recno() 		- returns the current record number

empty(STRING)   - returns .t. if STRING is empty or contains only blank   spaces

upper(STRING)	- returns STRING in uppercase

lower(STRING)	- returns STRING in lowercase



(STRING indicates a character value or fieldname only.  NUMBER indicates a numeric value or fieldname only) 





Example logical expressions are:



1 = 1		- always returns true

2 = 1		- always returns false

name = 'desk'	- only returns true when the word 'desk' starts the field NAME

recno() > 20 	- returns true only for record numbers over 20





The functions are as follows;



Add Records		- Adds records to the bottom of the current database. Enter the number of records to add.



Copy Structure to 	- Copies only the structure (empty database) to the supplied filename.  

			(Without affecting the original at all.) 



Copy to 		- Copies the entire database to a new file. (Without affecting the original at all.) 



Count for		- Counts the number of matches a logical expression 	finds in the database. 



Delete for  		- Deletes records according to the supplied logical expression.

			 (True means deleted, false means 	ignored.) 



Go/Goto		- Go directly to the supplied record number. 



Recall for 		- Undeletes (before a PACK) deleted records according to the supplied logical expression. (True 				means undeleted, false means ignored.) 



Replace for 		- Replaces records according to a supplied logical expression, by replacing the supplied fieldname with 			the supplied value (can be blank) 

























The Free Format Report Generator
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	A report is basically a printed copy of your database.  To provide the most flexibility, MultiWorks Database gives you a free-format report generator.  To use it, first select the file you want to create a report from, then select the "Create" option from the Reports Menu (F8), and enter a file name for this report.  If you have already created a report, and only wish to modify it, select the "Modify" option from the option Reports menu, and select the desired filename with the File Selector. 



	The report editor is a stripped down version of the word processor.  It has the ability to handle lines up to 250 characters long, and to insert valid field names from a list invoked by pressing the F2 key.  The typeface control characters that work with the word processor, also work with the Report Generator (ie ALT B = bold, ALT N = normal ... ). 



	A report generally contains both data and comment text.  There are two types of comment text.  The first, called Headings, print only the first time they are encountered after a formfeed.  Only one Heading is allowed per report, although it can span several lines.  The second, called Titles, print every time. 



	To enter a Heading, simply enclose it with curly brackets {}.  To enter a Title, simply type the text where you want it to appear on the page.  To print data, position the cursor at the position you want the data to appear, and then type a '<' sign, followed by the field name, and closed with a '>' sign.  The field name is the name of a particular database record.  If you are unsure of the names, press the F2 key and a scrollable list will appear at the right hand side of the screen.  Selecting the desired field name and pressing enter will cause it to be automatically inserted wherever the cursor was before you pressed the F2 key.  



	To enhance the printed quality of your report use the Style menu (F9) or any of the standard keystrokes to add typeface and font control characters. 



	Press the ESC to save the report and return to the database menu.  



MOUSE - Point and click anywhere within the report text to move the cursor to that position. 





Printing a Report



	To print a report select the "Print" option from the Reports menu (F8).  You then must select the number of records to be printed before a form feed is set.  This allows you to print several multi-line reports on one page without worrying about overrunning the page break.  Set this value to zero to suppress all form feeds until the entire report has printed.





How it Works



	Operating the report generator is quite simple once you understand the basics.  MultiWorks starts at record number one (or whatever the range filter has been set to), and starts reading from the top of the report.  Each item is printed as it appears. Once MultiWorks has reached the end of the report, it advances the record pointer by one, and returns to the top of the report.  This continues until all of the records have been printed, the End Range filter setting has been reached, or the print has been interrupted by the user (ESC). 

The Fixed Format Report Generator



	The Fixed Format Report Genarator is similar to the Free Format one, in that it allows you to dsiplay or print the data from your database in a custom format.  The main difference lies in the fact that the Fixed Format Generator displays data in columns, allows functions and expressions, and can total any numeric data.



	To create a Fixed Format Report, first make sure the database file that you want to use has been opened with the Database, and then select "Fixed Format Reports" from the Report pull down menu (F8).





Loading an Existing Report



	To retrieve a report already created, from disk, choose "Load Report" from the File pull down menu (F2) and then select the desired filename from the list.  Fixed format report files use the file extender ".FRP".





Creating a New Report



	To create a new report, select 'Create Report" from the File pull down menu (F2) and supply a filename.  A new report file will be generated.  You must define the page options before defining the column options.





Saving a Report



	Fixed format reports are saved automatically each time a change is made.





Defining a Page
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	To modify the page settings in a report, select the Page pull down menu (F3).  A 'page' in the Fixed Format Report Generator refers to the layout of the header information, as well as global settings such as width and line spacing.



Page Title



	The page title can be one to four lines long, and is automatically centered to the current page width.  Press ESC to exit from the Title Create box.



Page Width



	The page width can vary between 10 and 160, and limits the combined column widths, as well as acting as a guide for centering the page title.



Left Margin



	The left margin is an optional space at the left hand side of the page.  The value does not affect the page width setting.



Lines Per Page



	The value determines the total number of data lines per page.  Keep in mind that the page title, column title and total/subtotal lines are not counted in this value.



�Double Spacing



	This options toggles double spaced printing on and off.  Select 'Yes' for double spacing, or 'No' for single spacing.





Reporting Scope



	This value is a logical expression which is used to limit the records that are included in the report.  Please see the section in the chapter pertaining to 'Special Functions' for more information.





Defining a Column
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	To modify the contents of a column, select the "Column" pull down menu (F4).  Each column can contain the information from one or more fields or the result from an equation.



Column Title



	Like the page title, the Column Title can be from one to four lines line.  Press ESC to exit from the Title Create box.  Unlike the page title, the Column Titles are not automatically centered.



Column Contents



	This is a one to eighty character field that stores the field name or equation that is actually printed.  For a list of valid functions and operators, please see the section on "Special Functions".



Column Width



	This value limits the number of characters that any one column can take up.



Column Totals



	With this option set to 'Yes' in a numeric column, the values will be added together and a final total printed on the last page of the report.  Sub totals will also be printed at the bottom of each page.



Moving Between Columns



	To move between columns press the PageUp or PageDown keys.  To add a new record (one at a time), press PageDown at the last defined column.





Printing



	Select the "Print" pull down menu (F5) to print.  Depending upon your Reporting Scope, all or some of the records will be printed.





Field Names



	The Field Names manu may be accessed by pressing F10.  This menu will display all of the fields in the current database, and if you select one and press enter, allow you to paste it into the Contents field of the current column.





Filter Settings
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	There are three type of filter settings that can be made from the Settings menu (F9).  These settings affect the way that a database is Browsed, Edited and Reported upon.  





Set Filter



	The first, actually called "Set Filter" is the most complex.  It requires a valid Logical Expression. See the definition under 'Special Functions'.  Only records that evaluate to True will be displayed. 





Set Fields



	The second, "Set Fields" allows you to choose the fields to be displayed in the Edit and Browse Modes.  When you select this option, you are presented with a menu listing all the fieldnames of the current database.  Select a fieldname (highlight it) and press enter to select it (a check mark will appear beside it).  Only those fields that have the check mark beside them will be able to be Browsed or Edited, until you select the "Clear Fields" option.  





Set Range



	The third setting, "Set Range" is quite straight forward.  With this setting you can set the top and bottom limits of the records to display.  Use the "Clear Range" option to reset these value to encompass the entire database.  





Last Database Autoload



	In order to make jumping between the different sections of MultiWorks 15, easier and less time consuming, a feature called File Autoload has been implemented.  In the Database, this feature ensures that the file you are currently using when you exit the Database is automatically reloaded the next time you re-enter it.  This allows you to use the different features of MultiWorks without having to worry about constantly reloading your current database.  The filename and directory information for the Autoload feature is updated each time a new database is selected.  When you select 'Close Current', the information will be cleared, and the next time you enter the Database, you will be starting from scratch. This feature is also present in both the Word Processor and the Spreadsheet. 

�The Spelling Checker



	The Spelling Checker is an application that goes through your entire document word by word and compares each to its predefined dictionary.  If the word does not exist, the spell checker will question you.  You may then correct the word, ignore it, or add it to the dictionary.  
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Choosing a Document



	The first part of spell checking a document is to choose the document itself.   Press the F2 key and select the desired document with the File Selector.  





Checking a Document



	Press the F3 key to start the spell check.  A backup of the original document will be made (with an extender of ".BAK").  The Spell Checker will now start comparing the words in your file to the ones in its dictionary.  When a word is not found it will be displayed in the middle of the screen.  At the bottom of the screen, the word will be displayed in context. 



When an unknown word is found, you will have several options; 





Adding a word to the Main dictionary



 	If the word is spelled correctly, and you wish it added to the main dictionary, press the ENTER key.  





Correcting the word



	If the word is indeed spelled incorrectly, you have two options; 





Choosing a word from the dictionary



	Pressing the spacebar will open up a small "word window", and allow you to scroll through a list of the words that the application thinks might be the correct ones.  If you find the correct word in the list, place the cursor on top of it, and press ENTER twice.  The incorrect word will be replaced by the selected word and the application will then continue checking the document. 



MOUSE - Point at the desired word in the window and click to select it. 







Entering the correct word manually



	If you cannot find the correct word in the word window, press ESC, and then enter the word in the space provided.  The incorrect word will be replaced by the entered word and the application will continue checking.  





Adding a word to the Rejects file



	If the word is unknown by the dictionary, but not the sort of word you would want to add permanently (such as a proper name), press the TAB key and it will be added to the "rejects" file.  Any future occurrences of this word will be ignored.  The advantage to the rejects file (REJECTS.DBF) is that it can be edited or cleared easily by using the database. 





Ignoring just one occurrence



	To ignore just the present occurrence of a word, press the ESC key, if the word is encountered again, the check will be interrupted again.  





Aborting the spell check



	Finally, if you wish to abandon the spell check altogether, press the Q key.   The unchecked portion of the document will be written to the end of the file.  





Locating a word



	For the times when you need to find the spelling of a single word, and don't feel like creating a document just to check it, use the Locate Word option (F4).  ENTER the word (or part) to find, and if it is found within the dictionary, it will be displayed along with any other words similar to it.  





�The Address Book



	The Address Book is a list of names and address information, sorted into alphabetic order.  Unlike a paper address book, names are not separated by pages, instead the entire Address Book is one long list that you can browse through.  The list can be browsed one name at a time, or a whole page at a time.  You can even move directly to a name instantly.  Also unlike the paper address book, the MultiWorks Address Book allows names to be printed as mailing labels.  As well, each entry may have a memo pad attached to it of up to 64K in length that can be accessed with a single keystroke. 



	For clarity, the term "Entry" will be used to describe a single name with its attached address, telephone, memo, and group information.
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The Address Book Structure



	The Address Book screen is split approximately in half.  On the left hand side will be a scrolling list of each entry's names that are currently stored.  On the right hand side will be a detail display of the entry currently highlighted on the left.  



MOUSE - point at the desired entry name and click to select it.  Click on the up/down arrow or pageup/pagedown symbols to move quickly through the list. 





Editing Entries



	To edit or add information to a specific entry first locate it in the list on the left and then press ENTER.  The cursor will move to the detail display on the right, and allow editing.  Make your changes/additions and then press ENTER on the last line to make the changes permanent.  



MOUSE - Click anywhere in the name detail area to edit the entry currently selected. 





Adding New Entries



	Select the 'Add New Label' option by pressing F2, and then fill in the blanks.  If you cannot fill all of the blanks immediately don't worry, you will be able to edit or add to the information later on.  The final blank in each entry is a field called 'Group'.  To select a group name for each entry, press ENTER in this field.  This will cause a popup menu to appear, with a list of the available groups.  Select one, and press ENTER.  To add a new Group, select 'Define New Group' from the Group pull down menu.  For more information on groups, see 'Groups' in this chapter.  When you are finished each entry press ENTER on the last line.







Copying Entries



	You may make a copy of an existing entry by positioning the cursor on it and pressing ALT V.  A new entry, identical to the original will appear directly below it.  





Searching Through the List



	There are several ways to locate a specific entry from the list.  The first way to select an entry, is to type the entry's name (if you know it) one character at a time.  As you enter each character, the letters you have typed will appear at the bottom of the list, and the cursor will move to the first entry whose name starts with those letters.  Moving the cursor manually, or pressing any non alpha-numeric key will cause the search to be reset. The second method is to press the F3 key and enter a search key.  This search key must be the first part of the entry's name, contact name or title.  For example, to search for John Smith, you would enter "John" or "John S" or even "Jo" 





Switching the Order of First and Last Names



	To switch the position of the first and last names in an entry, select it and press ALT S.  To switch back to the original, press ALT S again. 





Dialing the Telephone



	If you have a Hayes(tm) or compatible modem connected to your computer through any of the COM: ports, you may use it to dial the phone for you.  To do so, first make sure that your modem is on, and that it is connected properly.  The telephone that you wish to use must be connected to the modem itself, and the modem to the Line in cable (from the wall).  Refer to the Maintenance screen to select the COMmunications port, the type of phone line you are connected to and an optional dialing prefix (useful for an office with a switchboard).  Now highlight the entry for the person or company you wish to call, and press the END key.  This  brings up a pop-up menu containing all three telephone numbers from the highlighted entry.  Select one and press ENTER.  If connected properly, your modem will now begin to dial.  Wait until the program prompts you to pick up the handset, and then press any key. 
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Deleting Entries



	While in the edit mode, pressing DELete will cause a pop-up box to appear, asking you to delete the Entire Entry or just the contents of the Memo Pad.  If you opted to delete the entire entry, it will not actually be removed until you return to the main menu.  Until that time, you may un-delete it by reselecting it and pressing DELete again.  With a Colour monitor, the right hand (detail) side of the screen will be displayed in red when any deleted entry is selected.





Selecting Labels for the "Print Several" option



	While in the browse mode pressing the TAB key will toggle the print status of the selected entry.  With a Colour monitor, labels selected for printing are displayed with a green background on the right hand (detail) side of the screen.  Monochrome users should look for the word '* Print *' above the Name field on the right hand side.  When you choose the Print Several option, only the tagged entries will be printed.  





Clearing The Print Status of Selected Labels



	After using the Print Several option to print a group of tagged entries, you may reset their tagged status by selecting 'Clear Print Tags' from the Print pull down menu.

Printing the Current Entry



	To print the only the entry currently highlighted, you may press ALT P or select 'Print Current' from the print menu(F5).





Printing Multiple Copies of one Entry



	To print the entry currently select several times, select 'Print Multiple' from the print menu(F5), and then select the number of copies you wish to print.







Printing Selected Entries



	To print the enties selected with the TAB key, press F6 or select 'Print Several' from the print menu(F5).





Printing the Entire List of Entries



	To print all the entries shown in the current group (to print every entry in the entire Address Book make sure you in 'View All' mode), press F7 or select 'Print All' from the print menu(F5).





Printing the "Black Book"



	Press F8 or select 'Print Black Book' from the print menu(F5), to print a alphabetized series of pages (3 per 8.5 x 11 paper).  After printing, you may cut between the dotted lines and then staple in order to produce a transportable telephone book.  Only the entries in the current view group will be printed. 





Printing Specific Formats



	When printing with the Address Book you have several different output  options that can result in a multitude of different styles and formats.  The six most common styles have been placed in a menu for your convienience.  Select the Print Styles menu by pressing F10.  The styles are as follows:



Laser Envelopes	- For printing landscape envelopes on a Laserjet(tm) printer

DM Envelopes	- For printing portrait envelopes on an Dot Matrix printer

1" Labels	- For printing 1" continuous feed labels

1.5" Labels	- For printing 1.5" continuous feed labels

Shipping Labels	- For printing a label in a very large font with the 

		  HP Laserjet III(tm)

One Liners	- To print only the first line (name) of each label





Defining your Own Print Styles



	If you need more options, you can create your own styles by pressing F10 for the Print Styles pull down menu and selecting the first option 'Define New Style'.  Fill in the Style description box that appears, and your new print style will be added to the list.  Please be sure that your printer can handle attributes such as Landscape, or odd font styles before you select them.



The options in the Style Description Box are as follows:



Labels / Envenlopes	- Choose between printing a page of entries or a single 			one at a time.

Portrait / Landscape	- Choose between useing the Portrait or Landscape mode 			of your laser printer.

Label Length		- Choose the number of lines per label (usually 6 per 				inch)

Font 			- Choose which font to use (if supported)





Deleting a User Defined Style



	To delete a style that you created, and no longer need or want,  select the Print Styles pull down menu, and move the cursor on top of the desired style name.  Now press the DELete key and it will be deleted.  Please note that only user defined styles may be deleted, those that came with the program (the first six) cannot.





Label Printing on Centre Feeding Laser Printers



	Many Laser printers, including the Hewlett Packard Laserjet II, IID, III, IIID etc, have a centre feeding tray for odd sized pages.  To print labels on one of these printers you will need to set the three different codes, depending upon your printer.  Use the Driver (F7) option in the Maintenance screen.  If you have a Hewlett Packard LaserJet, most of the appropriate codes have already been set. 



	The first two codes, Letter and Legal refer to the commands that tell the printer the paper size (length) to be used.  Since most sheets of labels are longer than 11 inches, the printer must be told to use Legal sized paper to prevent a paper jam when printer labels.  The letter codes are necessary to return the printer to it's default state.  The third code to be set is the Label Definition code.  

	This code is in three parts, the first part (two digits) is the number of lines down to start the first label (most laser printers are unable to print at the very top of the label page, and therefore must skip to the second one).  The next part of the code (one digit) is either a "L" or a "C".  "L" refers to left hand feeding, and "C" is used for centre feeding.  The third part of the code (2 digits) is the number of labels per sheet (not counting any that are skipped at the top).  Make sure that the first and the last sections of the Label definition do take up two digits, even if they are less than 10, example : '03 or 07, or 11'.



	Once the codes have been set properly, you may print labels on your laser printer by feeding one strip in at a time, and pressing ENTER in between each.





Enhancing the Printed Output Quality



	To enhance the appearance of your printed envelopes and labels, you may select one of 6 character typeface attributes for each line printed.  Select 'Edit Label Formatting from the Print pull down menu (F5).  A dialog box will appear with labels for each line of the envelope or label.  Enter (B)old, (N)ormal, (U)nderline, (I)talic, (W)ide or com(P)ressed for each line.  The current Label formatting will appear at the bottom of the screen next to the print status box. 





Groups



	When adding an new name, or editing an old one, you can specify the 'group' to which it will belong.  A group can be any name from 1 to 20 characters long.  Press the HOME key to change the current group being viewed, or to Enter a new one.  To change the current view group, simply select it from the menu.  To add a new group, select 'Define New Group' from the menu, and Enter the desired name.  Label entries can be added to a group either when the are first Entered (see Adding new Labels), or by changing the contents of the Group field in edit mode.  The option 'View All Groups' allows the display of all entries in the list. 
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�The Time Manager



	The Time Manager is an easy and simple way to keep track of dates and appointments, as well as maintain a 'To-Do' list.  The calendar can reference any date within the calendar year, and hold notes of up to 64K for each date.  Each time you enter the Time Management application, the current month will be shown with the current date highlighted.  
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The Time Manager Structure



	There are three parts or modes to the Time Manager.  The first, the Calendar mode, is the mode that is active when the Time Manager is first invoked.  The Calendar mode allows you to select a date to enter information for, as well as perform large scale editing.  The other three modes can only be reached through this mode.  The second mode, the Note Pad, can be access by selecting a date and pressing the ENTER key.  There is a different Note Pad for each day of the year.  Return to the Calendar mode from the Note Pad mode by pressing the ESC (notes are automatically saved).  	The third section is the Alarm mode, accessible by pressing the F3 key or the spacebar.  Within this section, alarms are added or edited.  Press the ESC to return to the Calendar mode.  





Moving through the Calendar



	Use the left and right cursor keys to move one day at a time, or use the up and down cursor keys to move one week at a time.  The pageup and page down keys move the view one month at a time. 



	You may also jump directly to a date, or count forward or backward a specified number of days.  To do any of these movements, press the F6 'Goto' key.  Modify the displayed date to go directly to that date.  Or insert a number in either (or both of) the Ahead or Backward blanks.  Any combination of these functions will cause the selected or computed date to be displayed in the calendar. 



	The current month and date (the date, in the format MM/DD/YY) will be displayed at the top of the calendar. Any date that has a note attached to it will have a "*" beside it.  A date with alarms shows a "!" beside it, and a date with both will display a "#".  



MOUSE - Click on any displayed date to move the cursor to that position.  Click on the up/down arrow or the page up/down symbols to move through the calendar.  Click within the alarm box to edit alarms, or within the note pad area to edit it. 





�Counting Days
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	In order to quickly count the number of days  between any two dates, highlight the starting date and press ALT E.  Then highlight the ending date of the range and press ALT  F.  You will see a display showing the number of Weekdays (Monday to Friday), the number of Weekend days (Saturday & Sunday) and a total for both.





Entering Information



	When the desired date is highlighted, press the ENTER key to enter the Note pad mode.  Enter your information and then press the ESC key to return to the Calendar.  





Editing in the Note Pad
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	While in the Note pad, the cursor keys move left and right and up an down, and the pageup/pagedown keys move a page at a time.  Use the standard editing keys to delete a few characters.  The F9 key deletes the entire contents of the note pad.   Press the F6 key to insert an item separator.  An item separator is simply a horizontal line that can be used to quickly break up a note pad entry into logical sections. 





Note Pad Copy & Paste



        	To save time and effort, the Time Manager allows you to copy and paste note pad contents between days.  To do so, first enter the desired source note pad, and press the F2 key.  Then return to the Calendar mode, choose the destination date, and enter it's note pad mode.  Then press the F3 key to copy.  Press the F4 key in any note pad mode to clear the copy buffer. 





Deleting all Information for a Specific day



	While in the Calendar mode, highlight the desired day, and press the DELete key to remove both the entire note pad, and alarm contents. 





Annual Information



	An annual appointment book entry is one that appears automatically on the same date each year.  This facility is ideal for keeping track of birthdays, anniversaries, and other yearly events.   There are two ways to create an annual entry. 

	The first way is to press the F4 key while in calendar mode.  This will make the entire contents of the current day annual. (including alarms, and all the information in the note pad).  To verify that a day has been marked as Annual, the word 'Annual' will appear at the top right hand corner of the note pad box.  Press F4 again to remove the Annual status. 



	The second way is to enter the note pad, type in a line, and then press the F4 key while the cursor is on the selected line.  This operation will place an 'infinity' symbol at the beginning of the line.  This line is now marked as Annual, and only it, or other lines so marked will be copied to the same date next year.  To remove the annual status of such a line, simply delete the infinity symbol. 

Adding a new Year to the Calendar



	To save disk space, adding a new year to the calendar is a manual process.  Press the F2 key in the Calendar Mode and a new year will be added to the end of the database.  This new year is always the year following the previous last year.  To remove old dates from the calendar, first; delete all effected alarms and notes.  Then with the database, remove all the dates (one week at a time) from the database file DATE.DBF.  





Removing an old Year from the Calendar



	To save diskspace, or to simply clear out unwanted information year by year you have the ability to remove an entire year's worth of notes and alarms.  To do so, first position the cursor anywhere within the desired year. (for safety's sake you cannot remove the current year)  Then press the F7 key and answer 'Yes' to the prompt.  The selected year will be removed, and the cursor repositioned to the current date. 





Setting the Alarms
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	While in the calendar browse mode, pressing F3 or the spacebar will switch to the alarms entry window.  Although only 9 alarms are shown at a time, there are in fact 15 alarms per day available.  To reach the others, use the cursor keys to scroll up and down.  To set an alarm, simply enter the time you want the alarm to ring at (in 24 hour format) and followed by an optional alarm message.  



	If you leave MultiWorks in any application, an alarm will ring and the appropriate message will be displayed when the alarm time is reached.  If you leave MultiWorks entirely, and return on the same day after the alarm time it will ring and display the intended time. 





Printing



	Time manager information can be printed in a variety of ways.  Press F5 while in the calendar browse mode to bring up the print menu.  



	The first option 'Monthly Calendar' has two modes.  The first is a full page monthly calendar for the currently highlighted month (Single Month), and the second (Entire Year) is a yearly calendar for the current year.  The second option under the print menu 'Daily Appointments' produces a printout containing the currently highlighted day's alarms, monthly calendar (for the current month), and the contents of the note pad. 



	Two more options exist to allow the printing of notes.  The first 'Notes by Date' allows you to specify a the start and end of a range of dates to print.  The second 'Notes by Key' allows you to print all notes that contain a common key word or phrase.  Both of these options print the date of each note, and a separator line between each. 





The Auto Alarm Feature



	The Auto Alarm feature is a great time saver when you use the F10 (insert time of day marks) in the edit note mode.  If the Auto-Alarm switch (in the Maintenance Screen) is set to "ON", and you add an appointment beside the time mark, this appointment will be entered into the alarm list for the current day.  This allows you to make notes and set alarms MultiWorks step! 

�The File Encryptor



	The File Encryptor / Decryptor is a simple way of preventing unauthorized access to your text files.  The encryptor/decryptor uses a user supplied password to encrypt or decrypt each file.  Be very careful not to forget the password that you used, otherwise you will never be able to decrypt the file! 
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Choosing a File



	 To encrypt or decrypt a file, it must first be selected with the load file option (F2).  Any length file can be encrypted, but be warned; large files can take an extended amount of time.   You should only try to encrypt text files or databases that contain character type fields.





Encrypting a file



	Once the file is selected, press F3 to encrypt it.  You will then be prompted to enter a 1 to 20 character password (to abort the process, press the ESC key).  After entering your password, and entering it again to confirm, the file will be processed.  When complete, the new format of the file will be displayed for your approval.  Use the cursor control keys to browse through the file, or ESC to exit.  This view mode is simply to verify that the file has been properly encrypted.  





Decrypting a file



	To decrypt a file, first make sure that you have the correct password. If you do not, attempts to decode the file will only make things worse.  



	Invoke the "Decrypt" option by pressing the F4 key.  Then enter the correct password (yes case is important) twice to verify.  The file will be decrypted according to the password you entered, and then displayed.  Again, use the cursor keys to browse, and ESC to exit.  If you entered the correct password, the file will be properly decrypted.  





Viewing a File



	In order to double check the file's status, you can use the F5 option to view the file presently loaded.  Use the cursor keys to move around it, and the ESC to exit.  This mode does not change the file in any way.  





�Saving a File



	Once the file has been decrypted or encrypted to your satisfaction, press F6 to save it.  At this point you can save over the old file, or write a new one by Entering a new filename.  If you have selected a database file, this step is not necessary.





Warning!	As that it is often easy to forget a password, make sure you have a backup of the target file (unencrypted) on 		diskette somewhere.  Without the correct password, the encryption process is one way only. 

�The DOS Shell



	The DOS Shell is an application designed to make DOS functions easier to use and learn.  A DOS Shell eliminates the need to remember obscure commands, or memorize complicated syntax and structure.  



	The DOS Shell consists of 5 menus, File, Run, System, Print and Format.  Each of these menus contain several DOS functions, which are as follows: 
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The File Menu



	The File menu contains common commands that act upon, or are related to DOS files.  Be careful when deleting files; once deleted, it is beyond the scope of this program to undelete them. 



MOUSE - Some options in the DOS Shell allow the selection of multiple files.  To do so with the mouse, point at the desired filename and click with the left hand button. 





Copy File(s)



	First select the file or files (by pressing TAB instead of ENTER) to be copied and press ENTER.  (if you have selected multiple files, press ESC instead) When the "source" files have been chosen the "destination" File Selector will appear.  Select the drive and sub directory in which the files will be copied to and press ESC.  Answer 'Yes' to the dialogue box, and the files will be copied. 





Move File(s)



	This is much the same command, and works the same way as "Copy file", except that the source file is deleted after the copy is made. 





Delete File(s)



	Select a file or files to be deleted and then press ESC.  Answer 'Yes' to the dialogue box and the selected files will be deleted.  Caution! Once the files have been deleted, they cannot be recovered with this program.  





Rename File



	Select the desired file and press ENTER.  A dialogue box will appear and allow you to enter a new filename.  Press ENTER to effect the change or ESC to abort it. 

Lock File(s)



	Locking a file will protect it from being accidentally erased.  Select the desired file or files, and then press ESC. 





Unlock File(s)



	This will allow a previously locked file to be edited/deleted.  Select the desired locked file or files and press ESC. 



View File(s)



	This command reads in the selected file or files, and then displays them.   Text files are shown as text, database files a database files, and all others as text.  There is not editing possible in this mode, but you will be able to move through the file with the pageup and pagedown keys. 





Clear Diskette



	This is a very fast way of deleting all the files on a diskette without having to reformat it.  The disk must have been formatted at one point in the past for this to work.  





Copy Diskette



	This command uses the DOS 'diskcopy' function to quickly copy the contents of one diskette to another.  Simply insert the diskette(s) and key in the desired source and destination drive letters (A and/or B).  





View Directory



	Selecting this option will cause the entire contents of the current drive and directory to be displayed.  The format presented is identical to that produced by the 'DIR' command in DOS.  Press ESC to cancel the listing. 





Locate File



	This option searches your hard drive (one partition at a time) for a selected file.  If found, MultiWorks will display the directory where it is located.  When entering the file to search for, you may insert a drive letter prefix (ie 'D:') before the filename.  If you do not, then the current drive will be searched.  The filename to be searched for may contain wildcard characters (ie '*' or '?'). 





Exit



	Select this option to exit the DOS Shell and return to the main menu. 





�The Run Application Menu
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	This is an easy way to run any other program or batch file that can be found on your system.  Only files that end with .EXE, .COM, or .BAT can be executed.  When a file is run, approximately 4K of memory will be retained for MultiWorks use.  When you exit from the application, you will be automatically returned to the DOS Shell application of MultiWorks. 



	The first time you run a specific application, you will have to select it directly with the File Selector.  (use the "Select Other" option from the Run Application menu) After you have selected the external application to run, you will have the option of saving it for future use.  If you answer 'Yes' to the prompt, the program name and path information will be saved in the menu for a quick and painless execution the next time.  



	You can also choose to add parameter information (ie: /c to force colour mode, etc).  If the parameter information for the current application is not to be static, place a question mark '?' in the parameter box.  This is called a 'Live' parameter, because each time the application is loaded, you will be prompted to add a new parameter at this point.  This can be useful for applications such as word processors or text editors that require a filename for a parameter. 

	If you choose the program "COMMAND.COM" from your boot drive, you will find yourself back at the DOS prompt.  To return to MultiWorks from here, simply type "EXIT" and press ENTER. 



	To remove an item from the Run Application pull down menu, highlight it and press DELete.





The System Menu



	This menu contains commands that affect the entire system as a whole. 





Make Directory



	Simply enter the name for the new directory.  If you key a name alone, the new directory will be created in the current drive and directory. 





Remove Directory



	Enter the name of the directory that you wish deleted.  Remember that any files in that directory will be deleted! 





Change Volume Label



	This function allows you to easily change the volume label on the current drive.  Simply select this option, then Ener the label when prompted to.  





Set System Date



	To set or reset the current system date, select this option and Enter the new date in the standard MM-DD-YY format.  

Set System Time



	To set or reset the current system time, select this option and Enter the new time in the format HH:MM.  





Global Delete



	This option allows you to delete a file or files no matter where they reside on the disk.  You may also delete multiple files in one step by specifying a wildcard file specification rather than an actual filename (ie *.DOC or TEST.*). 



	Simply select this option from the menu, Enter the filename/file specification and then press ENTER.  When the dialog box appears, you have three options;  Selecting 'Yes' will cause all matching files to be deleted automatically.  Selecting 'No' will cancel the entire operation.  Selecting 'Confirm' will allow you to choose whether or not to delete each matching file on an individual basis. 





System Statistics
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	In order to easily determine the components that make up your computer system, select System Statistics from the System pull down menu.  The system information is broken into five main groups.  The first tells the computer type, and the processor that it is using.  The second group lists the types and amounts of memory installed.  The third group displays input/output devices such as printer ports, and disk drives.  The fourth group lists misc. information such as video memory and the status of the math coprocessor.  The fifth group is the relative speed indicator.  This option tests your computer's speed and rates it against an IBM PC XT.  The XT comes in with a speed of 1.  On slower systems this test make take a few seconds.  For comparison, please use the chart below. 



IBM PC/PC XT (4.77 mhz)         		1.0

IBM AT (8 mhz)                  		4.4

Generic AT System (12 mhz)     		9.0

Generic 386sx System (16 mhz)  		9.5

Generic 386 System (16 mhz)     		12.5

Generic 386 System (25 mhz)     		19.2

Generic 386 System (33 mhz)     		27.5

Generic 486 System (33 mhz)		39.5

Generic 486 System (50 mhz DX2)	84.1





�Print Menu



Print File(s) (Foreground)



	This command simply copies the selected file or files to the printer.  MultiWorks will remain occupied until the process is complete.  Use the TAB option in the File Selector to select more than one file.  





Print File(s) (Background)



	This command uses the DOS 3.0 (or higher) PRINT function to perform simultaneous printing and MultiWorks operation.  Keep in mind that this option uses up some memory that will not be recovered until you re-boot your computer.  Up to 10 print files may be queued at one time.  Use the TAB option in the File Selector to select more than one file at a time. 





The Format Menu
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	Due to the four different types of diskettes currently available, and that the higher end diskette drives can format more than one density, formatting a diskette can be rather complex.  If you have a PC or XT compatible, your only option with 5.25" disks is the 360K format.  With an AT or compatible (286-386-486) and a 5.25" drive, you will be able to format either 1.2 megabytes, or 360K diskettes.  With a DD 3.5" diskette drive, you will only be able to format 720K diskettes, and with a HD 3.5" diskette drive, you will be able to format both 1.44 megabyte diskettes and 720K ones. 



	First select the format you wish to make, keeping in mind that above limitations.  Then select the drive to be formatted A: or B: (for safety's sake, other drives (like hard drives) cannot be formatted with MultiWorks.).   Insert the diskette into the appropriate drive and it will be formatted. 

�The Communications Package



	The Communications Package, sometimes known as a Terminal program, is a program or group of utilities used to communicate with another (remote) computer.  In most cases, this communication is done with modems connected through ordinary telephone lines.  Once connected to the remote computer, the user of a Communications package may exchange information, as well as send and receive programs and files.  Remote computers can include, Bulletin Board Systems (BBS's), Electronic services (CompuServe, DataPac),  Private institutions, (Company Mainframes, Bank Systems, Universities), etc.  The MultiWorks Communications program requires a Hayes Compatible Modem connected to a serial port. 
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Command and Terminal Modes



	The MultiWorks Communications program has two basic modes.  The first, the command mode contains the familiar command key list and pull-down menus.  The second mode, called the Terminal Mode is where all most of the communication with the remote computer is performed. 





The Terminal Mode



	The Terminal mode is where most of your interaction with the remote system takes place.  Anything you type while in this mode will be automatically sent to the remote computer (provided one is connected), and data sent from the remote computer will be displayed.  One connected, the only reason to leave this mode is to transmit or receive a file, or to terminate the connection.  From the Command mode press TAB or F10 to enter the Terminal Mode.  Press ESC to return to the Command Mode from the Terminal Mode. 





Local Character Echo



	When calling systems that do not automatically echo the characters you type, turn on the Echo mode from the Settings menu F4.  You may also set each of the entries in the dial directory to their own Echo status.  The default state is OFF.





�Dialing a Telephone Number
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	There are two ways to dial a telephone number.  The first, Manual Dial is performed by selecting Manual Dial from the Dial pull down menu.  Simply enter the desired phone number and press ENTER.  The other method uses the Dial directory.  To add a number to the Dial Directory, select Edit Directory from the Dial pull down menu and insert the new number and configuration information.  Once entered, a telephone number can be dialed by choosing Dial Directory from the Dial menu and selecting the desired name from the list. 





Redialling the Last Number



	As that many electronic services are popular and used frequently, it often takes several calls to connect.  To redial the last used number, select Redial Last Number from the Dial Menu. 





Sending a Text File to the Remote Computer



	To send a plain text file, select Send ASCII File from the File pull down menu.  This process simply 'dumps' the contents of the selected file across to the other computer, exactly as if you had typed it in Terminal Mode.  This option is most useful if you wish to create your data beforehand and then send to the other computer as if you were typing it in. 





Capturing Text from the Remote Computer



	To make a copy of the data being sent from the remote computer, select Capture ASCII from the File pull down menu.  Selecting this option turns on the "Capture" buffer which collects all of the data sent from the other computer while in Terminal Mode from that point onward. 





Saving the Captured Data



	To save the data collected in the "Capture" buffer, select Save Capture File from the File pull down menu.  This option allows the contents of the "Capture" buffer to be saved as a file.  This option also clears the capture buffer after it is saved. 





Uploading a file via XMODEM�

	To send a file to the remote computer in such a manner that the transmission is checked for errors, select Transmit XMODEM from the File pull down menu.  Like Send ASCII, Transmit XMODEM allows large amounts of information to be sent with one command.  Unlike Send ASCII, this command performs error checking that ensures the file will be received correctly. 



	To initiate an XMODEM Transmission, first inform the other computer of your intent.  On most Bulletin Board Systems, you will be requesting an Xmodem (CRC or Checksum) Upload.  When the other computer is ready, press ESC to return to the Command Mode.  Select Transmit XMODEM from the File Menu, and select the desired file to send.  The transmission process will begin, and the file will be sent block by block.  When successfully completed, you may return to Terminal Mode. 

Uploading a file via YMODEM



	This procedure is exactly the same, except that the YMODEM protocol is selected.





Downloading a file via XMODEM



	To receive a file from a remote computer and have it automatically checked for transmission errors, select Receive XMODEM from the File pull down menu.  XMODEM Receive is the exact opposite of XMODEM Transmit.  Here you are requesting a file from the other computer that will be sent to you and saved on your disk.  



	To receive a file, first tell the remote computer to perform an XMODEM (CRC or Checksum) Download of the desired file.  If the host computer informs you of the size of the file to be sent, take note of the number of blocks.  Then press ESC to return to the Command Mode, and select Receive XMODEM from the File Menu.  Enter the filename you wish the received file to be saved as and press ENTER.  Enter the number of blocks to be received and press ENTER.  (Please note that this second prompt is totally optional, and affects only the graphic display of download progress)  The file will be received block by block, and when complete, saved on your disk.  





Downloading a file via YMODEM



	YMODEM is another file transfer protocol, but unlike XMODEM it allows several files to be sent in a series.  To download, first select the desired file from the Host system, and then select YMODEM Download.  Filenames are automatically transfered with the rest of th file information.  All you need to do is wait.





Breaking the Connection



	On most modems, Selecting Hang Up from the Dial pull down menu (F3) will cause the connection to be broken immediately. 





Answer Mode



	In the event that you wish to receive a call, instead of placing it, you may instruct the modem to pick up and answer the phone.  To do so, wait until you hear the telephone ring, then select Answer Mode from the Dial Pull down menu (F3).  This will cause the modem to 'pick up' the phone and attempt to answer the call.  If successful, you can now proceed to terminal mode as usual. 





�Host Mode



	The Host Mode allows access to your system from another computer, without you being present.  To activate Host mode, select "Host Mode" from the Dial pull down menu (F3).  You may now enter a security password.  This password ensures that only authourized users may access your system.  At this point the system will wait for a call.  When a remote user calls, the system will ask them for the security password, if it was defined.  If the remote user inputs the password properly, they will gain access to a number of commands.  These commands are as follows:



HELP		- Lists all available commands with a short description



UPLOAD	- Allows the remote user to upload a file.  The filename is checked against existing files to insure that no loss of 		data occurs.



DOWNLOAD	- Allows the remote user to download a file from your system.



SEND		- Allows the remote user to send a message.  Messages can be up to 4000 bytes long and are ended with the "/*" 		sequence.  Messages are saved in the MultiWorks directory using the names MESSAGE.??? where ??? is a 			number between 1 and 999.



EXIT		- This allows the remote user to logoff the system properly and allow the system to wait for the next call.





Setting the Baud Rate



	To change the speed that your modem transmits and receives at select Set Baud Rate from the Setting Menu.   Then choose a speed (that your modem is capable of) from the displayed menu and press ENTER. 





Setting the Parity



	To change the current parity setting, select Set Parity from the Settings pull down menu.  Choose None, Even or Odd.  (most Bulletin Board Systems use 'None') 





Setting the Data Bits



	Electronic Services transmit data with either 8 bits or 7 bits per character.  Most Bulletin Board Systems send with 8, and most mainframe systems at 7.  Be sure of which you are connecting to before setting this option.  You should be able to determine what setting to use before calling the service.  To change the current setting select Set Data Bits from the Setting Menu. 





Setting the Stop Bits



	Electronic Services transmit data with either 1 or 2 stop bits.  Like the Data bits, this information is usually available before you call.  To change the current setting select Set Stop Bits from the Setting Menu.  (most Bulletin Board Systems use a setting of 1) 





Resetting the Modem



	Occasionally your modem will require resetting.  This usually occurs when the modem does not respond to ordinary commands.  Select Reset Modem from the Settings Menu to correct this problem. 





Exiting the Communications Package



	Selecting Exit from the File pull down menu, or pressing ESC while in Command mode will return you to the MultiWorks Main Menu.  If you are still connected to a remote computer, keep in mind that this will not cause the connection to be broken. 

Operation with Slower PC systems



	Please note that some older  (and slower) PC's may not be able to use the Higher baud rates such as 4800 and 9600.  If this problem occurs, reduce the speed and try again.



�The Info Manager



	The Info (information) Manager is a specialized database used to quickly store and retrieve various bits of information.  Information is stored in the form of records.  Each record contains a Subject, a Category, a Date and a Note Pad.  Categories can be viewed altogether, or one by one. 
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The Info Manager Structure



	There are four main parts to the Info Manager, the command bar, the reference line, the subject window and the note pad window.  The command bar is the familiar line across the top of the screen that displays command options.  The reference line is the line immediately below the command bar, which contains the current record's category, subject name and date.  The Subject window is a scrolling list that contains the subjects names of all records.  The Note Pad window is an area where the information attached to each record may be view or edited. 





Adding a New Record



	Press INSert or select Add New from the File pull down menu to add a new record.  Fill in the Category and Subject fields, then press ENTER to add data to the note pad.  Each time a new Category is entered, it will be automatically added to the Category list. 





�Editing an Existing Record



	Once a record exists, you can edit it in one of two ways.  The first way is to press ENTER and edit all of the information, including Category, Subject and Date.  The second method is activated by pressing the Space bar.  This allows you to edit only the Note pad.  Either way, pressing ESC during the edit will return control to the Subject window. 



	While editing the note pad, the following keys are active for editing and print enhancement. 



ALT B  		- Bold 

ALT I  		- Italic 

ALT N  		- Normal 

ALT P  		- Compressed 

ALT Q  		- Superscript 

ALT U  		- Underline 

ALT W  	- Wide

ALT Z  		- Subscript 

CTRL N	- New Font



ALT L 		- Delete current line

INSert 		- Toggle insert and overwrite modes



MOUSE : Click in the Note Pad window to edit, click on the reference line to edit that, and click back in the Subject window to return control. 





Changing the Category View



	Once you have a fair amount of data entered under several different categories, it can become necessary to view only one category at a time.  To do so, press the HOME key to display the Category list.  Select the desired category to view, and press ENTER.  Only the records whose categories are the same as the one selected will now be shown.  Select 'All Categories' to view the entire list again.  To remove an old category from the Category list, select it and press DELete. 





Deleting an Entire Record



	To delete an entire record, and remove it completely from the database, press DELete, or select Delete Entry from the File pull down menu.  





Deleting only the Note Pad



	To delete only the contents of the Note Pad, select Delete Note from the File pull down menu.  





Deleting a Category Heading



	To delete a category heading, press the HOME key, and select the desired heading from the list and press DELete.  If there are any entries still under that category, you will be asked whether or not you wish them deleted.  Warning : if you answer "Yes", all records under that category will be deleted.





Searching for Subject Text



	With a large list of Information Subjects, it can take some time to roll through, looking for the desired subject.  To search quickly for the desired subject press ALT S or select Locate Subject from the Search pull down menu.  Enter the Subject name (or part of) (case does not matter) and press ENTER to begin the search.  The cursor will be moved to the first matching occurrence. 



Searching Again (Subject)



	If you have already performed a successful Subject search and wish to locate the next occurrence, press ALT N or select Locate Next from the Search pull down menu.  If there exists another match within the Subject list, the cursor will be moved to it. 





Searching for Note Pad Text



	If you have filed some information, and cannot remember what subject name it was filed under, you may search the Note Pad text for a matching text string.  To do so, press ALT F or select Find Note Text from the Search pull down menu.  Enter the word or phrase (case does not matter) to search for and press ENTER.  If the text is found, the cursor will be moved to the appropriate subject, and the information displayed in the Note Pad window. 





Searching Again (NotePad)



	If you have already performed a successful Note Pad search and wish to locate the next occurrence of the same text, press ALT A or select Find Again from the Search pull down menu.  If another match exists the cursor will be moved to it. 





Printing a single Record



	To print the record currently being displayed, select Print Current from the Print Pull down menu.  It will be printed regardless of it's print status. 





Printing several Records 



	To print more then one record, but less than all, first select the records to print be moving the cursor to them, and pressing the TAB key.  You may also select Tag for Print from the Print pull down menu.  Records that are selected for printing will display the word 'Print' at the top right hand side of the note pad window.  Once all desired records are tagged for printing, select Print Selected from the Print pull down menu.  Each record will be printed on a separate page. 



Printing All Records



	To print all the records in the category currently shown, select Print all from the Print pull down menu.  Each record will be printed on a separate page.                                                                         





Importing and Exporting with the Clipboard



	In order to exchange data with other MultiWorks applications, you can use the Clipboard.  To Export the current record, press F4.  To Import the contents of the clipboard (provided that they are smaller than the current segment size) press F3. 





Exiting the Info Manager



	Press ESC to return to the MultiWorks main menu. 



�The Maintenance Screen 



	The final menu item in MultiWorks is the Maintenance Screen.  This screen allows you to customize MultiWorks toy your liking.  There are two kinds of configuration methods, Actions and Queries.  Actions are activated with the function keys and cover settings such as Passwords, Function Keys and File Indexing.  Queries on the other hand require you to fill in information in response to certain questions. 
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The Action options are as follows: 



Help - F1 



	This option brings up help for the Maintenance screen. 





Merge Time Manager and Address Book Information - F2 



	This option allows you to update the files of your main or "Parent" copy of MultiWorks, from the files of another copy "Child".  Before executing this option, make sure you have the child files on another diskette, or in another subdirectory.  Enter the drive name and/or path name where the child files reside (do not include actual files names), and press ENTER.  The program will copy all NEW records from the child files.  The child files themselves are not affected in any way. 





System Upkeep - F3 



Optimizing 



	Applications such as the Address Book, the Info Manager and the Appointment book use a special type of file to store notes.  These files (that end with ".DBT") tend to grow much faster than they should.  To bring them back to a manageable size, select Optimize from the Upkeep pull down menu.  This will cause the files to be compacted down to a (usually) much small size. 



Reindexing 



	Many of the MultiWorks application depend upon indexed files for faster operation.  In the event that any of these files become corrupted, you may wish to re-index them.  Re-indexing will not hurt any existing data, but it may take some time.  





�Set Function Keys Macros - F4 



	There are 30 function key macros available, three for each function key (SHIFT, ALTERNATE, and CONTROL).  Simply select which mode to program, and then enter the desired text.  Use a semi-colon ';' to simulate a carriage return.  These macros can be used in the word processor, the report generator, the time manager, or at any text prompt.  



	To insert non-standard characters and ASCII codes, place each numeric code between Greater and Less than symbols '<>'.  For example; the check mark is <251>, an ENTER keystroke would be <13> and ESCape would be <27>. 





Clear Function Keys - F5 



	This option resets all function key macros to blank. 





Set/Change Password - F6 



	As a measure of extra security, you can set a password system to blank the screen and lockup the keyboard after a user-defined period of time.  To enter the password for this system, select the "Set Password" option.  If this is the first time a password is being entered, you will only have to enter the new password.  If a password exists, you will have to enter the old one first. 





Modify Printer Driver - F7 



Font Codes



	If your printer supports multiple fonts, you may wish to use them when printing.  To do so, you must supply the appropriate control codes to the printer.  



	Space has been provided for up to 5 fonts, if you wish more, you must add more fields from within the MultiWorks Database.  To do so, select the Database from the main menu, and press F2 and select 'Load Database'.  Find the file called 'DRIVERS.DBF' in the MultiWorks directory and select it.  Now press F2 and select 'Modify Existing'.  The database's internal structure will be revealed.  Press PageDown until you are at the very bottom of the list of fields.  Add new font fields with the name 'FONT_??' where ?? is a number that is one (1) greater than that of the Font Field directly above it, and less that 99.  Use a field type of "C"haracter and a field width of 40 (can be larger or smaller depending upon your needs).  When complete, press ESC and then return to the Maintenance screen to edit the field contents. 



	The first font field (FONT_1) is reserved as the printer's default font.  This allows the MultiWorks applications to return the printer to it's default settings when complete.  If you are adding a new printer driver, or modifying an existing one, please be sure to follow this guideline. 



	To edit a font code sequence, simply select the font number from the menu and press ENTER.  Then simply enter the appropriate printer code for the desired font.  To imbed an ascii 27 (ESCape) character use '|'.  To imbed other non standard characters, surround their ascii codes with '<>' brackets. 





Typeface Codes



	This option allows you to add and edit the printer codes that drive your selected printer.  Simply fill in the proper printer code beside each attribute.  As that some printers require the ESC character (CHR(27)) to be sent ahead of the printer code, an uppercase '|' anywhere within the printer code will be interpreted as the ESC.  To add other special, non-typeable characters such as CHR(18) or CHR(15) surround the number with Greater and Less than ("<" and ">") symbols (ie <15> or <18>).  When you press ENTER they will be converted to the appropriate character. 





�The Query options are as follows:



MultiWorks Home Directory



	This is the drive and pathname that MultiWorks expects to find it's main data files. (such as the address book, dictionaries, etc).  Unless you want to maintain two (or more) complete and separate sets of data, the only time you would need to change this setting is if you are moving MultiWorks from one drive/directory to another.  To move MultiWorks properly, first create the new directory, then copy the existing files into it.  Now run MultiWorks 15 from the original directory and change the Home Directory name to reflect the new directory.  Now erase the contents of the original MultiWorks directory. 





Valid Drives



	To avoid errors, MultiWorks polls all available drives and writes a list of those that respond to the configuration file every time the files are re-indexed.  MultiWorks performs this poll by writing a small file, and then erasing it.  This is a good way to detect any read/write drive, unfortunately, it doesn't work with read only drives.  If you have a read-only drive connected, the only way to access it is by adding its drive letter to the valid drives list.  Inversely you can inhibit access to a certain drive by removing its letter from the list.  





System lock at Startup



	This prompt asks whether or not to demand a password when MultiWorks 15 is first loaded.  Answer 'Yes' to add this protection.  





Inactive delay



	This is the period in seconds that the system will wait after the last keystroke before clearing the screen and locking the system.  For example 300 seconds is 5 minutes. 





Printer



	The word processor uses several character formatting attributes to produce better looking documents.  As that most printers seem to use different control codes to produce these effects, I have included a library of printer drivers.  To select a particular printer, invoke this option, highlight the appropriate printer and press ENTER.  If your printer does not appear in the list, see "Adding a New Printer" in the Word processing Section.  





Print Device



	This is the physical connection used to connect your printer to your computer.  (for example PRN, LPT1, LPT2, COM1, COM2, etc)  If you are using a Network, PRN is the best setting. 





Word Processor Segment Size



	This allows you to select the maximum segment size for the Word Processor.  The default setting allows a file of up to 10 megabytes to be edited.  If you have enough memory, or don't plan to change the document size very much, this value can be increased.  If your PC is short on memory, make this number smaller. 





Word Processor Auto Save Query



	This prompt turns the Auto Save feature on and off.  If on,  the word processor will automatically save your document  at the specified time interval.





Word Processor Auto Save Time Interval



	Enter the number of minutes to wait between each automatic document save.





Word Processor Auto Backup Query



	This prompt allows you to turn the automatic backup feature on and off.  If it is On, each file will be automatically backed up before editing.  This option should not be used  on systems with  limited storage capabilities .





Word Processor Auto Load Query



	As that it is not always desirable to autoload a word processor file, you have the ability to turn this feature off.  Selecting 'Yes' will enable the Word Processor autoload, and 'No' disables it. 





Word Processor Auto Load Filename



	This is the file that the Word Processor will automatically load each time it is invoked.  When you Load a new file and then save it, this new file becomes the Auto Load filename.  Use this option to change it manually. 

Spreadsheet Maximum column size



	The default spreadsheet width is 26 columns (A-Z).  If you have sufficient memory, you will be able to increase this width up to 702 columns (A-ZZ).  





Spreadsheet Auto Load Filename



	This is the file that the Spreadsheet will automatically load each time it is invoked.  Each time you Load a new file, this new file becomes the Auto Load filename.  Use this option to change it manually. 





Databases Auto Load Filename



	This is the file that the Database automatically loads each time it is executed.  Each time you Load a new database file, this new file becomes the Auto Load filename.  Use this option to change it manually. 





Time Manager Auto Alarm Status



	To set the ability of the "Time Marks" to be automatically converted to alarms.  (see Auto Alarms in the Time Management Section) 





To Do List Retention



	Determines the number of days that completed To-Do entries will remain in the History file before being purged. 





Modem Parameters



	Select the COMMunications port that the modem is currently connected to (1, 2, 3, or 4 for COM1: to COM4:).  Please Note; if you have a mouse connected to the system as well as the modem, make sure that the Communications Port value is not the same as the mouse port.  Select the Baud rate (speed), (110, 300 600, 1200, 2400, 4800, 9600), Parity (None, Odd, Even), and the Data Bits (7 or 8), the stop bits (1 or 2).  Select the type of phone line that the modem is connected to 'T' for touch tone, or 'P' for pulse (rotary or dial).  If the modem is connected to a telephone system in a business, it may need to dial a digit, or several digits to attain an outside line.  These digits are called the Prefix. 





Autodialer Home Area Code



	Enter your local area code here.  When using the Address Book Autodialer, phone numbers with different area codes that the Home Area Code, will have the digit '1' placed in front when they dial.  Phone numbers with the same area code, or a blank one will be dialed without either the area code or the '1'

�Trouble Shooting and General Use Tips 



Conserving Usable Disk space (for single floppy users only)



	Due to a regrettable lack of storage space on single diskette systems, it is often necessary make some modifications to the program.  The following is a list of ways to either free up new disk space, or conserve existing space. 



	The most dramatic way to free up disk space is to remove the Help files (HELP.DBF and HELP.DBT).  By deleting these files, you can save approximately 35K of disk space. 



	You may also (with the database) delete all the printer drivers in the DRIVERS.DBF file except for the one that belongs to your printer.  Then select PACK from the File Pull down menu to remove them. 



	Try editing the MW.BAT file to remove the MultiWorks logo. 



	Other less drastic ways of saving space involve limiting the use of certain MultiWorks features.  For example, don't use the Memo Pad in the Address Book, or the Note Pad in the Info Manager, at all.  And use the memo pad in the Appoint Book the least possible.  Also, do not try to edit files in the Word Processor larger than the current segment size, this will avoid the creation of temporary files. 



Missing Data Files



	If you have accidentally deleted one of the main system files (anything that ends with a '.DBF' or '.DBT') you will get a message that says: 'Database/Index file "???" no found. open error'  (??? is the filename of the missing file.) 



	In this situation, the best thing to do would be to try to undelete the missing file. (with one of the third party disk utilities available)  Failing that, locate the MultiWorks Program diskette and copy the missing files from it. 



Missing Index Files



	If for some reason one of the index files that MultiWorks uses (all end with ".NTX") becomes corrupted or is deleted, the program will act strangely, or fail to run at all.  Usually the system will come up with the error message 'Database/Index file "???" not found.  open error'.  If the program will not run at all, change to the MultiWorks directory and delete all the files that end with ".NTX" and then run MultiWorks again.  If the program runs, Enter the Maintenance Screen and select F2 Reindex files.  Both of these solutions may take a few minutes, but either should solve the problem. 



	Also try increasing the value in the FILES= statement in your CONFIG.SYS file (see INSTALLATION)



Memory Problems



	MultiWorks requires a bare minimum of 450K free memory to run, although 550K is recommended.  If your system is near the bottom of the scale, you may experience some problems.  If you find the Spreadsheet or the Word Processor terminating prematurely, you may need to adjust some settings.  In the Maintenance screen adjust the segment size for the Word Processor to a lower number, and try setting the spreadsheet maximum column setting lower as well.  Play with both of these setting until your system works more reliably. 



Overly Large System Files



	System files, such as the Address Book file and the Time Manager file tend to grow larger than they should after a lot of use.  When this happens they waste valuable disk space and should be cleaned up.  Select F2 Reindex Files from the Maintenance Screen and wait a few minutes.  File sizes should return to a reasonable size. 







WARNING :	Turning your PC off before properly exiting MultiWorks CAN 				cause a loss of data!

�Glossary



AUTOEXEC.BAT - A file that contains the names of programs to be automatically executed at the end of the Boot process.  The AUTOEXEC.BAT file may also contain any other command that is normally executed from the command prompt. 



CONFIG.SYS - A file that contains special commands and programs that may only be executed at boot time. 



ASCII - American Standard Code for Information Interchange, a standard way of representing characters numerically inside the computer 



Baud - The speed with which data is transferred through a modem.  The higher the number, the faster the transfer. 



Bit - The smallest and most basic part of the memory system, a bit can hold only one of two values.  Like a light switch it has only two positions, ON or OFF.  On is 1 and off is 0. 



Boot - The Boot is the automatic process that the computer performs every time it is turned on.  Most boots consist of memory checks, peripheral initialization, and the setting of options.  With the CONFIG.SYS and the AUTOEXEC.BAT files, the user may partially adjust the boot process. 



Buffer - A temporary storage area within the computers memory.  Buffers often bridge the speed gap between a computer and I/O devices (ie. a printer is limited by the speed of its mechanical parts and cannot match the electronic pace of the computer).  An output buffer, would receive data from the computer as fast as it is produced and would feed it at a slower rate to the output device. 



Bug - An unpredictable error caused by program malfunction.  Known to some programmers as 'features'. 



Byte - Eight bits or enough to represent one character.  If you had eight light switches lined up, you would be able to produce up to 256 different combinations.  In the computer's memory, each combination represents one character. 



Character - A single letter, digit or special sign.  Example: "A B c 3 2 1 , . ! &". 

Chip - A small wafer of silicon that contains the circuitry to perform some task(s) or function(s) (ie memory or processor) 



Computer - A machine which processes instructions to manipulate data at high speeds, they do exactly what they are directed to do. 



Cursor - The square or underline character which indicates the current editing position (ie where the next character will be typed) 



Default - The standard or currently used setting.  For example, when you go to your car in the morning, it's default state is locked.  When you unlock it, the default state becomes unlocked, and will remain that way until you lock it again. 



Destination - The second file referenced in a two file operation.  This is the new file or the file created by the operation.  The destination can also be the directory that a new file will be written to. 



Directory - A special kind of file that can hold other files.  Most often used to help organize a disk.  (you would be wise to put all your document files in a single Directory to avoid confusion).  When a directory is within another directory it is sometimes called a sub-directory.  A directory is like a file-folder in a file cabinet. 



File - A distinct collection of related information or data. 



Filename - An identifying label for a file.  The filename consists of a one to eight character 'body' and a zero to three character extender.  If an extender is present, the two must be separated by a period. 



Hardware - The physical components of a computer (i.e. monitor, keyboard, printer) - visible and tangible. 



K - The standard measurement of computer memory or storage capacity.  A "K" is 1024 bytes.  A typical IBM PC has 640"K" of memory.  A typical diskette has 360"K" of storage, and a typical fixed or hard disk has 2000"K" (often known as 20 megabytes) 



�Megabyte - 1000K or 1040960 bytes 



Modem - A device (peripheral) that allows computer data to be sent across telephone lines by converting the digital information into the electrical equivalent of the human voice.("analog signal")  To decode the information at the other end of the line, another modem is needed. 



Peripheral - An item of hardware that provides extra functionality to the computer system.  ie: printer, diskdrive, etc. 



Program - A series of instructions which cause the computer to perform a series of functions or operations in a desired order.  Programs can be generally classified as either system programs or application programs. 



Software - A set of instructions issued to a computer that instruct it to perform a specific task. 



Source - The first file referenced in a two file operation. This is the 'original' file or directory.  If you are copying a file from one disk to another, the file that exists on the original diskette would be called the source file. 



Wildcards - Consist of either the character "*" or the character "?".  Wildcards can be used to represent groups of filenames or parts of filenames that are different or not known.  The "*" can represent the last part, or the whole of a filename or an extender.  (help.doc = *.doc ... help.doc = help.*) The "?" character can substitute for one character within the filename or the extension. (help.doc = h?lp.d?c)  The wildcard feature is very useful when you are performing an operation upon multiple files.  For example, to copy all the files in a particular disk to another disk, you could type "copy a:*.* b:" (copy everything on drive a:[source] to drive b:[destination]), or to get a listing of all the filenames that end with .DOC, you would type "dir *.doc"





